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Introduction
Thank you for purchasing the Engine Combustion Pressure Analysis.

This user’s manual contains useful information about the functions and operating
procedures of the software.   To ensure proper use of the software, please read this
manual thoroughly before beginning operation.  After reading the manual, keep it in a

convenient location for quick reference in the event a question arises.
This software loads files (.hdr and .wvf files) containing engine combustion pressure data
that was measured by the DL708E, DL716, DL750, or WE7000 and performs analysis.

The analysis results can be saved in CSV format and easily opened by a spreadsheet
program such as Microsoft Excel.  The type of engines that can be analyzed differ
depending on the measuring instrument as follows:

DL708E: Max. 6 cylinders
DL716, DL750, WE7000: Max. 8 cylinders

Note
• This manual applies to version 4 of the Engine Combustion Pressure Analysis or

Monitor Function of Engine Combustion Pressure.

• The contents of this manual are subject to change without prior notice as a result of
improvements in the software’s performance and functions. Display contents
illustrated in this manual may differ slightly from what actually appears on your screen.

• Every effort has been made in the preparation of this manual to ensure the accuracy
of its contents.  However, should you have any questions or find any errors, please
contact your nearest YOKOGAWA representative listed on the back cover of this

manual.
• Copying or reproduction of all or any part of the contents of this manual without the

permission of Yokogawa Electric Corporation is strictly prohibited.

Trademarks
• Microsoft, Windows, and Windows NT are trademarks or registered trademarks of

Microsoft Corporation in the United States and/or other countries.
• Adobe and Acrobat are trademarks of Adobe Systems Incorporated.
• The company and product names used in this manual are not accompanied by the

trademark or registered trademark symbols ((TM) and (®))
• Other company and product names are trademarks or registered trademarks of their

respective holders.

Revisions
1st Edition March 2004
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Overview of This Manual
This manual consists of seven chapters and an appendix as described below.

Chapter Title Description

1 System Configuration Describes the various hardware and software
configurations needed for different applications of the
software.

2 Overview Provides an overview of software functions as well as
an explanation of the software setup procedure, the
directory structure, and the software screens.

3 Screens and Operations Gives descriptions of the various screens included in
the software, and how they are used.

4 CSV Files Provides a list of items that can be saved to .csv files.

5 Equations Explains how each item is calculated.

6 Monitor Function (Add-On) Gives an overview of the monitor function and how to
set it up, and provides an explanation of the various
software screens associated with the monitor function
and how to operate them.

7 Error Messages Provides a list of error messages.

Appendix Explains how to set up the WE7000 and DL750.

Index

Conventions Used in This Manual
• The following symbols and codes are used in the tables that describe the software’s

settings and display data.

• Data Type
C : Character string
I : Integer

F : Floating point

• Size
For numerical data
10.2

Total number of characters displayed (including the decimal point, 
+/− signs, e and E)(no. of bytes)

Number of digits displayed before the decimal point (no. of bytes)

For character strings
38

Maximum number of bytes

• When necessary for clarity, key names of the measuring instrument and items that
appear on screen are set in boldface.
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Terms and Conditions of the Software License

NOTICE - PLEASE READ CAREFULLY BEFORE USE
Thank you very much for purchasing this medium containing a software program and related documentation provided by Yokogawa Electric
Corporation (hereinafter called “Yokogawa”), and the program contained, embedded, inserted or used in the medium (hereinafter called the
“Yokogawa Software Program”).

By opening this package or plastic wrapping (hereinafter called “Package”) enclosing  the Yokogawa Software Program, you acknowledge that you
understand and agree to the “Terms and Conditions of the Software License” (hereinafter called “Terms and Conditions”) which is written in the
documentation and separately attached.  Accordingly, the Terms and Conditions bind you.

The Yokogawa Software Program and its related documentation including ownership of copyright shall remain the exclusive property of Yokogawa
or those third parties from whom sublicensed software in the Yokogawa Software Program is licensed.

Yokogawa hereby grants you permission to use the Yokogawa Software Program on the conditions that you agree to the Terms and Conditions
before you open the Package and/or install it in or onto a computer.

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS, YOU CANNOT OPEN THE PACKAGE, AND MUST IMMEDIATELY RETURN IT
TO YOKOGAWA OR ITS DESIGNATED PARTY.

Terms and Conditions of the Software License
Yokogawa Electric Corporation, a Japanese corporation (hereinafter called “Yokogawa”), grants permission to use this Yokogawa Software
Program (hereinafter called the “Licensed Software”) to the Licensee  on the conditions that the Licensee agrees to the terms and conditions
stipulated in Article 1 hereof.
You, as the Licensee (hereinafter called “Licensee”), shall agree to the following terms and conditions for the software license (hereinafter called
the “Agreement”) based on the use intended for the Licensed Software.
Please note that Yokogawa grants the Licensee permission to use the Licensed Software under the terms and conditions herein and in no event
shall Yokogawa intend to sell or transfer the Licensed Software to the Licensee.
Licensed Software Name: Engine Combustion Pressure Analysis (model: 707765), Monitor Function of Engine Combustion Pressure (model:
707768)
Number of License: One each

Article 1 (Scope Covered by these Terms and Conditions)
1.1 The terms and conditions stipulated herein shall be applied to any Licensee who purchases the Licensed Software on the condition that the

Licensee consents to agree to the terms and conditions stipulated herein.
1.2 The “Licensed Software” herein shall mean and include all applicable programs and documentation, without limitation, all proprietary

technology, algorithms, and know-how such as a factor, invariant or process contained therein.

Article 2 (Grant of License)
2.1 Yokogawa grants the Licensee, for the purpose of single use, non-exclusive and non-transferable license of the Licensed Software with the

license fee separately agreed upon by both parties.
2.2 The Licensee is, unless otherwise agreed in writing by Yokogawa, not entitled to copy, change, sell, distribute, transfer, or sublicense the

Licensed Software.
2.3 The Licensed Software shall not be copied in whole or in part except for keeping one (1) copy for back-up purposes.  The Licensee shall

secure or supervise the copy of the Licensed Software by the Licensee itself with great, strict, and due care.
2.4 In no event shall the Licensee dump, reverse assemble, reverse compile, or reverse engineer the Licensed Software so that the Licensee

may translate the Licensed Software into other programs or change it into a man-readable form from the source code of the Licensed
Software.  Unless otherwise separately agreed by Yokogawa, Yokogawa shall not provide the Licensee the source code for the Licensed
Software.

2.5 The Licensed Software and its related documentation shall be the proprietary property or trade secret of Yokogawa or a third party which
grants Yokogawa the rights.  In no event shall the Licensee be transferred, leased, sublicensed, or assigned any rights relating to the
Licensed Software.

2.6 Yokogawa may use or add copy protection in or onto the Licensed Software.  In no event shall the Licensee remove or attempt to remove
such copy protection.

2.7 The Licensed Software may include a software program licensed for re-use by a third party (hereinafter called “Third Party Software”, which
may include any software program from affiliates of Yokogawa made or coded by themselves.)  In the case that Yokogawa is granted
permission to sublicense to third parties by any licensors (sub-licensor) of the Third Party Software pursuant to different terms and conditions
than those stipulated in this Agreement, the Licensee shall observe such terms and conditions of which Yokogawa notifies the Licensee in
writing separately.

2.8 In no event shall the Licensee modify, remove or delete a copyright notice of Yokogawa and its licenser contained in the Licensed Software,
including any copy thereof.

Article 3 (Restriction of Specific Use)
3.1 The Licensed Software shall not be intended specifically to be designed, developed, constructed, manufactured, distributed or maintained for

the purpose of the following events:
a) Operation of any aviation, vessel, or support of those operations from the ground;,
b) Operation of nuclear products and/or facilities;,
c) Operation of nuclear weapons and/or chemical weapons and/or biological weapons; or
d) Operation of medical instrumentation directly utilized for humankind or the human body.

3.2 Even if the Licensee uses the Licensed Software for the purposes in the preceding Paragraph 3.1, Yokogawa has no liability to or
responsibility for any demand or damage arising out of the use or operations of the Licensed Software, and the Licensee agrees, on its own
responsibility, to solve and settle the claims and damages and to defend, indemnify or hold Yokogawa totally harmless, from or against any
liabilities, losses, damages and expenses (including fees for recalling the Products and reasonable attorney’s fees and court costs), or claims
arising out of and related to the above-said claims and damages.

Article 4 (Warranty)
4.1 The Licensee shall agree that the Licensed Software shall be provided to the Licensee on an “as is” basis when delivered.  If defect(s), such

as damage to the medium of the Licensed Software, attributable to Yokogawa is found, Yokogawa agrees to replace, free of charge, any
Licensed Software on condition that the defective Licensed Software shall be returned to Yokogawa’s specified authorized service facility
within seven (7) days after opening the Package at the Licensee’s expense.  As the Licensed Software is provided to the Licensee on an “as
is” basis when delivered, in no event shall Yokogawa warrant that any information on or in the Licensed Software, including without limitation,
data on computer programs and program listings, be completely accurate, correct, reliable, or the most updated.
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4.2 Notwithstanding the preceding Paragraph 4.1, when third party software is included in the Licensed Software, the warranty period and terms
and conditions that apply shall be those established by the provider of the third party software.

4.3 When Yokogawa decides in its own judgement that it is necessary, Yokogawa may from time to time provide the Licensee with Revision
upgrades and Version upgrades separately specified by Yokogawa (hereinafter called “Updates”).

4.4 Notwithstanding the preceding Paragraph 4.3, in no event shall Yokogawa provide Updates where the Licensee or any third party conducted
renovation or improvement of the Licensed Software.

4.5 THE FOREGOING WARRANTIES ARE EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES OF QUALITY AND PERFORMANCE,
WRITTEN, ORAL, OR IMPLIED, AND ALL OTHER WARRANTIES INCLUDING ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE ARE HEREBY DISCLAIMED BY YOKOGAWA AND ALL THIRD PARTIES LICENSING THIRD
PARTY SOFTWARE TO YOKOGAWA.

4.6 Correction of nonconformity in the manner and for the period of time provided above shall be the Licensee’s sole and exclusive remedy for
any failure of Yokogawa to comply with its obligations and shall constitute fulfillment of all liabilities of Yokogawa and any third party licensing
the Third Party Software to Yokogawa (including any liability for direct, indirect, special, incidental or consequential damages) whether in
warranty, contract, tort (including negligence but excluding willful conduct or gross negligence by Yokogawa) or otherwise with respect to or
arising out of the use of the Licensed Software.

Article 5 (Infringement)
5.1 If and when any third party should demand injunction, initiate a law suit, or demand compensation for damages against the Licensee under

patent right (including utility model right, design patent, and trade mark), copy right, and any other rights relating to any of the Licensed
Software, the Licensee shall notify Yokogawa in writing to that effect without delay.

5.2 In the case of the preceding Paragraph 5.1, the Licensee shall assign to Yokogawa all of the rights to defend the Licensee and to negotiate
with the claiming party.  Furthermore, the Licensee shall provide Yokogawa with necessary information or any other assistance for
Yokogawa’s defense and negotiation.  If and when such a claim should be attributable to Yokogawa, subject to the written notice to
Yokogawa stated in the preceding Paragraph 5.1, Yokogawa shall defend the Licensee and negotiate with the claiming party at Yokogawa’s
cost and expense and be responsible for the final settlement or judgment granted to the claiming party in the preceding Paragraph 5.1.

5.3 When any assertion or allegation of the infringement of the third party’s rights defined in Paragraph 5.1 is made, or when at Yokogawa’s
judgment there is possibility of such assertion or allegation, Yokogawa will, at its own discretion, take any of the following countermeasures at
Yokogawa’s cost and expense.
a) To acquire the necessary right from a third party which has lawful ownership of the right so that the Licensee will be able to continue to use

the Licensed Software;
b) To replace the Licensed Software with an alternative one which avoids the infringement; or
c) To remodel the Licensed Software so that the Licensed Software can avoid the infringement of such third party’s right.

5.4 If and when Yokogawa fails to take either of the countermeasures as set forth in the preceding subparagraphs of Paragraph 5.3, Yokogawa
shall indemnify the Licensee only by paying back the price amount of the Licensed Software which Yokogawa has received from the
Licensee.  THE FOREGOING PARAGRAPHS STATE THE ENTIRE LIABILITY OF YOKOGAWA AND ANY THIRD PARTY LICENSING
THIRD PARTY SOFTWARE TO YOKOGAWA WITH RESPECT TO INFRINGEMENT OF THE INTELLECTUAL PROPERTY RIGHTS
INCLUDING BUT NOT LIMITED TO, PATENT AND COPYRIGHT.

Article 6 (Liabilities)
6.1 If and when the Licensee should incur any damage relating to or arising out of the Licensed Software or service that Yokogawa has provided

to the Licensee under the conditions herein due to a reason attributable to Yokogawa, Yokogawa shall take actions in accordance with this
Agreement.  However, in no event shall Yokogawa be liable or responsible for any special, incidental, consequential and/or indirect damage,
whether in contract, warranty, tort, negligence, strict liability, or otherwise, including, without limitation, loss of operational profit or revenue,
loss of use of the Licensed Software, or any associated products or equipment, cost of capital, loss or cost of interruption of the Licensee’s
business, substitute equipment, facilities or services, downtime costs, delays, and loss of business information, or claims of customers of
Licensee or other third parties for such or other damages. Even if Yokogawa is liable or responsible for the damages attributable to Yokogawa
and to the extent of this Article 6, Yokogawa’s liability for the Licensee’s damage shall not exceed the price amount of the Licensed Software
or service fee which Yokogawa has received.  Please note that Yokogawa shall be released or discharged from part or all of the liability under
this Agreement if the Licensee modifies, remodels, combines with other software or products, or causes any deviation from the basic
specifications or functional specifications, without Yokogawa’s prior written consent.

6.2 All causes of action against Yokogawa arising out of or relating to this Agreement or the performance or breach hereof shall expire unless
Yokogawa is notified of the claim within one (1) year of its occurrence.

6.3 In no event, regardless of cause, shall Yokogawa assume responsibility for or be liable for penalties or penalty clauses in any contracts
between the Licensee and its customers.

Article 7 (Limit of Export)
Unless otherwise agreed by Yokogawa, the Licensee shall not directly or indirectly export or transfer the Licensed Software to any countries other
than those where Yokogawa permits export in advance.

Article 8 (Term)
This Agreement shall become effective on the date when the Licensee receives the Licensed Software and continues in effect unless or until
terminated as provided herein, or the Licensee ceases using the Licensed Software by itself or with Yokogawa’s thirty (30) days prior written notice
to the Licensee.

Article 9 (Injunction for Use)
During the term of this Agreement, Yokogawa may, at its own discretion, demand injunction against the Licensee in case that Yokogawa deems
that the Licensed Software is used improperly or under severer environments other than those where Yokogawa has first approved, or any other
condition which Yokogawa may not permit.

Article 10 (Termination)
Yokogawa, at its sole discretion, may terminate this Agreement without any notice or reminder to the Licensee if the Licensee violates or fails to
perform this Agreement.  However, Articles 5, 6, and 11 shall survive even after the termination.

Article 11 (Jurisdiction)
Any dispute, controversies, or differences between the parties hereto as to interpretation or execution of this Agreement shall be resolved
amicably through negotiation between the parties upon the basis of mutual trust.  Should the parties fail to agree within ninety (90) days after
notice from one of the parties to the other, both parties hereby irrevocably submit to the exclusive jurisdiction of the Tokyo District Court (main
office) in Japan for settlement of the dispute.

Article 12 (Governing Law)
This Agreement shall be governed by and construed in accordance with the laws of Japan. The Licensee expressly agrees to waive absolutely
and irrevocably and to the fullest extent permissible under applicable law any rights against the laws of Japan which it may have pursuant to the
Licensee’s local law.

Article 13 (Severability)
In the event that any provision hereof is declared or found to be illegal by any court or tribunal of competent jurisdiction, such provision shall be
null and void with respect to the jurisdiction of that court or tribunal and all the remaining provisions hereof shall remain in full force and effect.

Terms and Conditions of the Software License
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Chapter 1 System Configuration

1.1 Hardware Configuration

You can set the TDC pulse as the trigger, then synchronize the engine cylinder pressure
and other signals to the angular pulse and perform measurement.

Actual driving Continuous operation

Off line
WVF files

4-cycle/2-cycle engines
Gasoline/Diesel/LPG/LNG engines

EXT-CLK

TRIG

Sensor

Monitor Function of 
Engine Combustion Pressure

Engine Combustion 
Pressure Analysis

DL750

WE7000

DL708E
DL716

TDC pulse

Cylinder pressure 
(up to 8 cylinders)

Intake manifold pressure
.
.
.

Other signals

Angular pulse
1.0  CA
0.5  CA
0.25CA
0.1  CA

Engine Dynamo

Ethernet

USB

3D graph

Cycle graph

Crank angle graph

CSV files
• Numeric analysis
• Crank angle graph
• Cycle graph
• Crank angle graph 
 of all cycles

Numeric analysisP-V graph

• PC System Requirements
OS: Windows XP, Windows 2000 Pro, Windows NT 4.0, Windows 98

However, Windows NT 4.0 is not supported when using USB.
CPU: Pentium III, 1 GHz or higher
Memory: 256 MB or more

Hard disk: 2 GB or more of free space

•  For the DL708E/DL716
• Main Unit

DL708E or DL716 (with internal hard disk)
Memory length > (no. of analyzed cycles + 3) × 1 cycle data length

For 4-cycle engines: 1 cycle data length = (360/res) × 2
For 2-cycle engines: 1 cycle data length = (360/res)

• Measurement module

701852/701853
However, ((RPM/60) × 360/res) < 100 kHz
res : angular resolution (1, 0.5, 0.25, 0.1)
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• For the DL750
• Main Unit

DL750 (with a Zip drive, PC card slot, or internal hard disk)
Memory length > (no. of analyzed cycles + 3) × 1 cycle data length

For 4-cycle engines: 1 cycle data length = (360/res) × 2

For 2-cycle engines: 1 cycle data length = (360/res)
• Measurement module

701251

However, ((RPM/60) × 360/res) < 1 MHz
res : angular resolution (1, 0.5, 0.25, 0.1)

• For the WE7000
• Main Unit

WE800 or WE400 (1 unit)

• Communications I/F
WE7035/WE7036, WE7037/WE7038, or WE7052

• Measurement module

WE7235, WE7245, WE7271/WE7272
However, ((RPM/60) × 360/res) < 100 kHz

WE7275

However, ((RPM/60) × 360/res) < 1 MHz
res : angular resolution (1, 0.5, 0.25, 0.1)

1.1  Hardware Configuration
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11.2 Software Configuration

Engine Combustion Pressure Analysis
• Loading Measurement Data

You can load saved .wvf files (Yokogawa’s proprietary format) containing cylinder
pressure  data from a 4-cycle or 2-cycle engine measured on the DL708E, DL750, or
WE7000.

A portion of this data (up to 800 cycles worth) can be extracted for filter processing,
rotational offset correction, or TDC correction, then analyzed.
By running the Monitor Function of the Engine Combustion Pressure Analysis

Package, you can analyze previously saved WVF files at the same time.

• Loading and Saving Analysis Conditions
You can save and load analysis conditions (TDC correction value, interval of absolute
pressure correction, analysis parameters, calculation data items, display window
layout, and graph display conditions).  The analysis conditions from the previous

session are automatically loaded upon start-up.

• Filter Processing
You can shape the waveform by applying filters (None, Lowpass, Bandpass,
Highpass) to motoring and firing pressure data, then perform rotational offset
correction, TDC correction, and combustion pressure analysis calculations.

• TDC Correction
Using motoring data, you can determine the offset between the TDC pulse position

and the actual TDC position, then perform analysis.  Or, you can enter the offset value
manually.

• Absolute Pressure Correction, Physical Value Conversion, and other Signals
You can assign channels to measurement signals.  You can assign channels 1
through 16 to cylinder pressure (up to 8 cylinders), intake manifold pressure, intake

manifold temperature, fuel consumption, rpm, and other signals.  Also, you can
specify the coefficients for conversion to physical values (calibration factors, A and B
in y=Ax+B).  Cylinder pressure is corrected to absolute pressure.

• Combustion Pressure Analysis/Results Display
• You can select multiple combustion pressure analysis items or input them

manually, then perform combustion pressure analysis.
• After the analysis, you can select computed items one at a time for graphical or

numerical display.

• New manually input items and analysis items can be entered or selected so that
additional calculations can be performed.

• Saving Analysis Data in CSV Format
You can save test information (settings at time data was saved), manually input items,
and calculated analysis results data in CSV format.
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Monitor Function of Engine Combustion Pressure
The Monitor Function of Engine Combustion Pressure (hereinafter, the Monitor Function)

is an add-on for the Engine Combustion Pressure Analysis.
This function is only available when used in conjunction with the Engine Combustion
Pressure Analysis.

With the Monitor function, you can use your WE7000 series instrument (WE7235,
WE7245, WE7271, WE7272, or WE7275) or the DL750 to measure cylinder pressure
over given periods of time during motoring or firing, and continuously monitor the

measurements.  You can also save the resultant data.  For details, see chapter 6.

1.2  Software Configuration
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Chapter 2 Overview

2.1 Overview of Functions

Procedure
Motoring Firing

WVF files WVF files

Motoring cylinder 
pressure measurement

Firing cylinder 
pressure measurement

TDC correction 
angle calculation

Enter manually input 
data items

Set coefficients for 
convertion to physical values 

(calibration factors)
Combustion 

pressure analysis

Set angle range for interval of 
absolute pressure correction

TDC correction 
value

Conversion 
coefficients 

(calibration factors)

Correction interval

Save results to CSV file

Loading Measurement Data
You can select a specific cycle range from the waveform data that was measured and
saved by the DL708E, DL716, DL750, WE7000, and load that selected portion of the
data into the software.
• Motoring data

Data for TDC correction
• Firing data

Data for combustion pressure analysis (signals coming from each channel, starting
with CH1, in the firing order)
• Number of cylinders: Up to 8 cylinders (or up to 6 cylinders for the DL708E)
• No. of cycles: Up to 800 cycles
• Angular resolution: 1, 0.5, 0.25, 0.1 CA

With this software, you cannot check whether or not the data meets the above
conditions.
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Filter Processing
You can apply filters to motoring data and firing data.  When applying filters, the first
cycle’s worth of data is always dropped to cancel out the effect of signal rise.  The
remaining data is treated as the raw data, and used for rotational offset correction, TDC
correction, and combustion pressure analysis.
• Filter types

None, Lowpass, Bandpass, Highpass
• Characteristics

4th order (24 db/oct) butterworth
• Cutoff frequency

• At 1 CA resolution, 7.2 order (times) of the number of revolutions (2%) – 72 order
(times) (20%)

• At 0.5 CA resolution, 14.4 order (times) of the number of revolutions (2%) – 144
order (times) (20%)

• At 0.25 CA resolution, 28.8 order (times) of the number of revolutions (2%) – 288
order (times) (20%)

• At 0.1 CA resolution, 72 order (times) of the number of revolutions (2%) – 720
order (times) (20%)

* The percentage in parentheses is the ratio relative to the sampling frequency.

% = specified multiple / ( 360 degrees / angular resolution (1, 0.5, 0.25, 0.1) ) × 100

For example, to apply a low pass filter with a 1 kHz cutoff:
At 3000 rpm (equivalent to 50 Hz),
Cutoff = 1 kHz divided by 50 Hz = 20 times the rpm.

When this process is carried out, the TDC correction value is calculated using the filtered
data, and all analyses are performed.

Measurement Data Review
To facilitate checking of measured data, the motoring and firing data are displayed in the

crank angle graph.
If filters were applied, filtered waveforms are displayed.

Rotational Offset and TDC Correction (Calculated on Motoring Data)
Since rotation pulse (TDC) signals are output once per revolution, there is an offset of
1/2 cycle for each single cycle of intake, compression, explosion, and exhaust.

Therefore, the crank angle at the maximum point of pressure is determined from within
one cycle’s worth of data, and if there is a pressure peak on the exhaust or intake stroke,
the first 1/2 cycle’s worth of data is discarded.

 

Rotation
pulse

Cylinder 
pressure data

Rotational offset: Yes
(peak on exhaust or 
intake stroke)

Rotational offset: No
(peak on compression 
or explosion stroke)

Measurement start

If the crank angle at the maximum point of pressure < −180 CA or 
if +180 CA < the crank angle at the maximum point of pressure, 
the rotational offset is set to "yes." 

In
take

E
xh

au
st

C
o

m
p

re-
ssio

n

C
o

m
p

re-
ssio

n

E
xp

lo
sio

n

In
take

E
xh

au
st

E
xp

lo
sio

n

In
take

E
xh

au
st

C
o

m
p

re-
ssio

n

C
o

m
p

re-
ssio

n

E
xp

lo
sio

n

In
take

E
xh

au
st

E
xp

lo
sio

n

Discarded data

2.1  Overview of Functions
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For the pressure data from the first cylinder during motoring, the software searches for
the maximum pressure value after the rotational offset correction is performed, then

determines the TDC position.  It then calculates the offset from the TDC pulse position.
This offset value is used for all analysis thereafter.

• TDC Correction Calculation Method
(1) You can compute the average data for all cycles of the cylinder pressure data from

the motoring data of the first cylinder.

Rotation pulse

Cylinder pressure 
data

Average 
cylinder pressure

1 cycle of data

(2) Using 10 CA's worth of data before and after the maximum pressure point of the
averaged cylinder pressure data, you can apply the least square method to compute
the crank angle of maximum cylinder pressure θX.

(3) The TDC correction value can be determined using θX.  The TDC correction value is
given as the amount of divergence of the maximum pressure point θX from the start
of measurement, and a correction value is determined such that the position of θX is
zero (CA).
See the figure below.

0θX

0
Discarded data

Measurement start

0

0θX

0

Data after correction

Data after correction

Discarded data

TDC correction 
value

TDC correction value

2.1  Overview of Functions
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Absolute Pressure Correction
You can convert measured cylinder pressure to absolute cylinder pressure.  For
example, cylinder pressure can be corrected so that the average cylinder pressure (on a
per cycle or all cycle basis) of the crank angle range near BDC (which can be specified
by the user) equals the atmospheric or intake manifold pressure.  You can manually
input atmospheric pressure (including boost pressure) or use measured intake manifold
pressure.

Padj

Cylinder pressure
data

Cylinder pressure
data

Pθin1 Pθin2 Pθin3

Pθin1 Pθin2 Pθin3

• When using the per-cycle average value

• When using the all-cycle average value

deg1 deg2

Average 
cylinder pressure

Padj1

deg1 deg2

Padj2

deg1 deg2

Padj3

deg1 deg2

Pressure after absolute pressure correction = Pθinn − Padjn + Pxn
 Pxn: Atomospheric pressure (including boost pressure) or intake manifold pressure

Pressure after absolute pressure correction = Pθinn − Padj + Pxn
 Pxn: Atomospheric pressure (including boost pressure) or intake manifold pressure

Average value across 
the specified crank angle 
range (deg1–deg2)

Average value across the specified 
crank angle range (deg1–deg2) 
at the average of all cycles

Other Signals
You can specify signals that are not to be used for combustion pressure analysis. There
are no physical units for the channels selected here.  Please consider these values to
have whatever units are appropriate for your application.  When converting voltage to
physical values, enter the conversion coefficients (calibration factors) A and B for the
equation y=Ax+B.  Also, note that absolute pressure correction is not performed on these
signals.
During analysis, cycle-averaged values are displayed in the crank angle graph, the
average value at each cycle is shown in the cycle graph, and the data can be saved in
CSV format.  TDC correction is based on the first cylinder.

Combustion Pressure Analysis/Results Display
Combustion pressure analysis can be performed after selecting combustion pressure
analysis items and entering manual input items.  After analysis, the analysis results for
the selected items are graphically or numerically displayed.

• Combustion Pressure Analysis Data Items
Crank Angle Graph
• Cylinder pressure
• Rate of cylinder pressure rise
• Amount of heat release

• Rate of heat release
• Combustion mass rate
• Cylinder gas temperature

• Polytropic index
• Raito of specific heat
• Other signals

2.1  Overview of Functions
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P-V Graph
• Cylinder pressure - Piston displacement graph
• Logarithmic cylinder pressure - Logarithmic piston displacement graph
Cycle Graph
• Maximum cylinder pressure
• Averaged maximum cylinder pressure of all cylinders
• Crank angle at maximum cylinder pressure

• Averaged crank angle at maximum cylinder pressure of all cylinders
• Maximum rate of pressure rise
• Averaged maximum rate of cylinder pressure rise of all cylinders

• Crank angle at maximum rate of cylinder pressure rise
• Averaged angle at maximum rate of cylinder pressure rise of all cylinders
• NMEP

• Averaged NMEP of all cylinders
• IMEP
• Averaged IMEP of all cylinders

• PMEP
• Averaged PMEP of all cylinders
• Maximum amount of heat release

• Crank angle at maximum amount of heat release
• Maximum rate of heat release
• Crank angle at maximum rate of heat release

• Crank angle at combustion mass rate N1 %
• Crank angle at combustion mass rate N2 %
• Crank angle at combustion mass rate N3 %

• Other signals
Analysis Data Items Graphed in 3D
• Cylinder pressure

• Rate of cylinder pressure rise
• Amount of heat release
• Rate of heat release

• Combustion mass rate
• Cylinder gas temperature
• Polytropic index

• Raito of specific heat
• Other signals

• Numeric Analysis Data Items
• Average cylinder pressure across correction interval

(When calculating the average pressure of the crank angle range determined from
the all-cycle average and applying the result to all cycles)

• Piston displacement
• Average, standard deviation, and rate of change of the maximum cylinder pressure
• Average, standard deviation, and rate of change of the maximum rate of cylinder

pressure rise
• Average, standard deviation, and rate of change of NMEP
• Average, standard deviation, rate of change, minimum, and LNV of IMEP

• Average, standard deviation, and rate of change of PMEP
• Rate of misfire
• Average, standard deviation, and rate of change of the maximum cylinder gas

temperature
• Average, standard deviation, and rate of change of the maximum rate of heat

release

2.1  Overview of Functions
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• Average, standard deviation, and rate of change of the maximum amount of heat
release

• Average, standard deviation, and rate of change of the angle at combustion mass
rate N1%

• Average, standard deviation, and rate of change of the angle at combustion mass

rate N2%
• Average, standard deviation, and rate of change of the angle at combustion mass

rate N3%

• Average start point of combustion (point a)
• Average end point of combustion (point b)
• Averaged maximum cylinder pressure of all cycles and cylinders

• Averaged maximum rate of cylinder pressure rise of all cycles and cylinders
• Averaged NMEP of all cycles and cylinders
• Averaged IMEP of all cycles and cylinders

• Averaged PMEP of all cycles and cylinders
• Minimum IMEP of all cycles and cylinders
• LNV of  IMEP of all cycles and cylinders

• Oxygen requirement
• Exhaust gas volume
• Theoretical air

• Theoretical exhaust gas volume
• Amount of water produced
• Theoretical volume of dry exhaust gas

• Excess air factor
• Intake air volume
• Intake fuel-air mixture volume

• Volumetric efficiency
• Specific gravity of fuel gas
• Mass of intake air

• Mass of intake fuel
• Mass of intake gas mixture
• Gas mixture constant

• True heat release of gas fuel
• Cooling loss
• Cooling loss ratio

• Brake thermal efficiency
• Friction loss
• Combustion efficiency

• Degree of constant volume
• Indicated efficiency

• Manually Input Data Items
• TDC correction values
• Conversion coefficients (calibration factors A and B)
• Unused channels

• Starting angle of correction interval
• Ending angle of correction interval
• Con-rod length

• Bore
• Piston offset
• Stroke length

• Clearance volume

2.1  Overview of Functions



2-7IM 707765-61E

O
verview

2

• Compression ratio
• Method of absolute pressure correction

• Number of data items for judging start point of combustion
• Number of data items for judging end point of combustion
• Starting angle of combustion

• Ending angle of combustion
• Search range of maximum rate of heat release
• Fuel consumption

• Atmospheric temperature
• Atmospheric pressure
• Revolutions per minute

• Boost pressure
• Engine power
• Number of cylinders

• Composition ratio of methane
• Composition ratio of ethane
• Composition ratio of propane

• Composition ratio of isobutane
• Composition ratio of n-butane
• Concentration of oxygen remaining in exhaust gas

• True heat release of gas fuel
• Ratio for judging angle of combustion mass rate (3 locations)
• Value for judging misfire

Saving Analysis Data in CSV Format
You can save absolute pressure analysis data in CSV format (.csv files).  You can enter

test information prior to saving.  The following seven types of items can be saved.  Raw
data cannot be saved.
• Test Information

• Test date
• Data name
• Testing personnel

• Department
• Test name
• Engine type

• Serial No.
• Place of test
• Test bench type

• Comments
• Manually Input Data Items
• Numeric Analysis Data Items
• Crank Angle Graph Data
• Cycle Graph Data
• Analysis Data for Other Signals
• Measured Intake Manifold Pressure, Intake Manifold Temperature, Fuel

Consumption, Revolutions per Minute, and Concentration of Oxygen Remaining
in Exhaust Gas

2.1  Overview of Functions
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Saving the Analysis Results of a Specified Range of Cycles
For the seven items below, the crank angle graph data from a specified range of cycles

can be saved in CSV format (as .csv files).
• Cylinder pressure
• Logarithmic cylinder pressure

• Rate of cylinder pressure rise
• Cylinder gas temperature
• Amount of heat release

• Rate of heat release
• Combustion mass rate

Saving Analysis Conditions
You can save conditions required for analysis in text format (as .ecp or .ecm files).
.ecp: When running the Engine Combustion Pressure Analysis only

.ecm: When running the Monitor Function of Engine Combustion Pressure Analysis
• TDC correction value
• Number of cylinders

• Interval of absolute pressure correction
• Coefficients for conversion to physical values (calibration factors)
• Filter setting conditions

• Calculation parameters
• Calculation execution items
• Analysis graph display conditions

• Screen layout

2.1  Overview of Functions
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2.2 Setup

Use the setup program on the CD to install the Engine Combustion Pressure Analysis.
Run the file, CD Drive /Disk1/Setup.exe.

If your operating system is Windows NT, 2000, or XP, log in as the administrator.
If a previous version of the software is already installed, you must remove it before
installing this version.



2-10 IM 707765-61E

2.3 Directory Structure

This software utilizes the following directory structure.

<Installation directory> (directory name specified during installation)†

<log>: Log file directory (error log, message log)

<Info>: .ini file directory

<work> (for use by application)

<Cal> (for use by application)

<IM>: User's manual directory (this manual, in PDF format)

<Sample>: Motoring/firing sample data directory

* If a previous version of the software is already installed, you must remove it before installing

this version.

† Only alphabetical characters and numbers may be used for the name of the installation

directory.
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2.4 Screens

Menu Bar and Icons for the Engine Combustion Pressure Analysis

Help menu

Help (display user's manual)

Window menu
Graph menu

Calculation menu
Settings menu

View menu
Edit menu

File menu

Restore the minimized window

Save screen to BMP file
Minimize the window

Move cursor
Start monitor function

Enter color settings
Enter cycle display settings

Enter axis range settings
Enter 3D graph settings

Execute calculation
Enter parameter settings

TDC and calibration factor settings
Enter filter settings

Save analysis conditions
Load analysis conditions

Save to CSV file
Load waveform data
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Chapter 3 Screens and Operations

3.1 Common Operations

Right-Clicking the Mouse
If you right-click on a window displaying a graph, the following shortcut menu appears.

• Measured Data: Opens a window displaying a crank angle graph of raw data and
corrected data.

• Crank angle graph: Opens a window displaying a crank angle graph of calculated
analysis items.

• Cycle graph: Opens a window displaying a cycle graph of calculated analysis items.

• Numeric Analysis Data Items: Opens a window displaying numeric analysis results
from calculated analysis items.

• 3D graph: Displays the graph dimension setting screen.  Select 2 or 3 dimensions,

and select 3-dimensional graph setting conditions (when the crank angle graph or 3-
dimensional analysis graph is displayed).
The range of cycles extracted from the raw data is set as the maximum range, crank

angle data is extracted every number of cycles specified by “by,” and the data is
displayed in a 3D graph.

• Axis range: Displays the graph axes setting screen.  You can set a fixed value for the
X and Y axes, or choose Autoscale.  These settings are entered for each graph.

• Display channels: Displays a pull-down menu for display channels.  This setting is
entered for each graph.
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• Cycles: Displays a setting screen for the displayed cycles.  These settings are
entered for each graph.

AVE: Displays a cycle average crank angle graph
ALL: Displays superimposed crank angle graphs of all cycles
Other: Displays a crank angle graph of the specified cycles

• Graph colors: Displays the graph color setting screen.  These settings are entered
for each graph.

Moving the Cursor
Values can be read in directly using cursors.  If you click in a window displaying a graph,
the cursor (a vertical bar) jumps to the point where the mouse was clicked, and the X

and Y axes of that point are displayed.  Also, the following buttons can be used to move
the cursor to the right or left in units of the angular resolution.

: Fast left cursor

: Left cursor

: Right cursor

: Fast right cursor

Displaying the Mouse Pointer Position
When the mouse is moved over a graph, the X and Y value of the current position is
displayed on the graph.

Saving Results to a BMP File
Press the  button to save a bit map image of the active graph window.

Displaying Help Information
You can display the user's manual in PDF format.  You can also choose About ECP to
display version information about the program.

3.1  Common Operations
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3.2 File > Load Measured Data

Functions
• You can select a measured data file to be loaded.

Filters can be applied according to the filter settings.

• Set the following for the data to be loaded:
• Number of strokes
• Range of cycles to be analyzed

• Crank angle resolution
• Model of measuring instrument

• If the measuring instrument is incorrect, a warning message is displayed.

Setting/Display Data

No. Item Default Setting Data Size Numerical Data Input (I) or
Type Min. Value Max. Value Select (S)

1 No. of Strokes Prev. value - - - - S

2 No. of effective cycles Prev. value I 5.0 1 25000 N.A.

3 Start cycle 1 I 5.0 1 25000 I

4 End cycle Number of effective cycles I 5.0 1 25000 I

5 Angular Resolution 1.0 CA - - - - S

6 Measuring Instrument DL716 - - - - S

(1) No. of effective cycles: When selecting the file to be loaded, the angular

resolution is assumed to be 1 CA, and the number of effective cycles is
calculated using the equation below.  If the angular resolution is changed to 0.5,
0.25, or 0.1, the number of effective cycles is updated accordingly.

(portion before the decimal (no. of measured data / no. of data per cycle)) − 3

The maximum number of effective cycles varies depending on the angular

resolution as follows.
• For 1 CA: 25000 cycles
• For 0.5 CA: 12500 cycles

• For 0.25 CA: 6250 cycles
• For 0.1 CA: 2500 cycles

(2) Start cycle, End cycle: Enter the range of cycles to be analyzed (up to 800

cycles).  You cannot enter a value greater than the number of effective cycles
for the data under analysis.

(3) Angular Resolution: Select 1, 0.5, 0.25, or 0.1 according to the conditions

during measurement.
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(4) Measuring Instrument: When loading files, the appropriate instrument is
automatically selected.  You can also change the instrument to the DL708E,

DL716, DL750, or WE7000.

Button Operations
Open Button

Selects the start and end cycles and advances to the raw data display screen.
If the number of start/end cycles selected exceeds the maximum number of cycles of

the data to be analyzed, a message is displayed.

Cancel Button

Clears all screen settings and closes the screen.

3.2  File > Load Measured Data
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3.3 File > Save Analysis Data

Functions
• Test information can be entered and combustion pressure analysis results can be

saved to a file in CSV format.

Setting/Display Data

No. Item Default Setting Data Size Numerical Data Input (I) or
Type Min. Value Max. Value Select (S)

1 Data Name Prev. value C 8 - - I

2 Testing Personnel Prev. value C 8 - - I

3 Department Prev. value C 16 - - I

4 Test Name Prev. value C 32 - - I

5 Engine model Prev. value C 16 - - I

6 Serial No. Prev. value C 16 - - I

7 Place of Test Prev. value C 16 - - I

8 Test Bench Prev. value C 16 - - I

9 Comments Prev. value C 32 - - I

10 Start cycle, End cycle Prev. value I 5.0 1 25000 I or  S

(1) Start cycle, End cycle: To save a specified range of cycles of crank angle
graph data from the analysis results to a CSV file, choose this command, then
enter the range of cycles to be saved.  The suffix “-all” is added to the specified

file name.  For example, if you name the file Sample, the actual file name will
change to Sample-all.csv when saved.

Button Operations
Cancel Button

Clears all screen settings and closes the window.

Save Button
Displays a window allowing you to specify the save location.  Clicking OK in that
window saves combustion pressure analysis results data to a text file in CSV format.

Raw data cannot be saved.
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3.4 File > Load Analysis Conditions

Functions
• Loads analysis conditions (TDC correction value, Number of cylinders, interval of

absolute pressure correction, coefficients for conversion to physical values (calibration
factors), filter setting conditions, calculation parameters, calculation execution items,
analysis graph display conditions, screen layout), and places them into effect as the

current conditions.  However, when choosing this command, all previously calculated
results are cleared, and any currently displayed analysis results windows are closed.
Display analysis results windows again after calculations have been performed.
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3.5 File > Save Analysis Conditions

Functions
• Saves analysis conditions (TDC correction value, Number of cylinders, interval of

absolute pressure correction, coefficients for conversion to physical values (calibration
factors), filter setting conditions, calculation parameters, calculation execution items,
analysis graph display conditions, screen layout).
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3.6 File > Start Monitor Functions

Functions
• Sets the communication interface for the PC, and WE7000 as well as the selected

measurement module and slot number.
• Sets the conditions for connection with the DL750.

• Displays the raw data display window.
• You can perform real time monitoring while running the engine combustion analysis

package.

Setting/Display Data

No. Item Default Setting Data Size Numerical Data Input (I) or
Type Min. Value Max. Value Select (S)

1 Number of Strokes Prev. value - - - - S

2 WE7000/DL750 Prev. value - - - - S

3 Communication Interface Prev. value - - - - S

4 PC-IP address Prev. value C 16 - - I

5 Net Mask Prev. value C 16 - - I

6 Port no. Prev. value C 5 1 64000 I

7 Measuring station Prev. value C 16 - - I

8 Measuring module Prev. value - - - - S

9 Slot no. Prev. value - - - - S

10 Ethernet/USB Prev. value - - - - S

11 DL750 IP address Prev. value C 16 - - I

12 User name Prev. value C 16 - - I

13 Password Prev. value C 16 - - I

14 DL750 USB ID Prev. value C 3 - - I

(1) Number of Strokes: Select a 2- or 4-cycle engine
(2) WE7000/DL750: Select the WE7000 or DL750 for the measuring instrument.
(3) Communication Interface (WE7000): Select Optical/Ethernet.
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(4) PC-IP address/Net Mask/Port no.: If Ethernet is selected for the
communication interface, enter the IP address, net mask, and port number of

the PC.  If the PC has only one network interface, the IP address and net mask
will be automatically assigned if you leave these fields blank.

(5) Measuring station: Enter the WE7000 station name.

(6) Measuring  module: Select the WE7235, WE7245, WE7271/WE7272, or
WE7275.

(7) Slot no.: Select the number of installed slots.  A range is indicated when

multiple modules are used.  When one module is used, enter the same number
into both boxes.

(8) Ethernet/USB (DL750): Select Ethernet/USB.

(9) DL750 IP address: Enter the IP address for the DL750.
(10) User name: Enter the user name for connecting with the DL750.
(11) Password: Enter the password for connecting with the DL750.  When the user

name is anonymous, no password is required.
(12) DL750 USB ID: Enter the USB ID of the instrument in the range from 1 to 127.

Button Operations
OK Button

Activates the settings entered in the screen, opens a connection with the measuring

instrument, and closes the window.
Cancel Button

Clears all on-screen settings, and closes the window.

3.6  File > Start Monitor Functions
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3.7 File > Close

Functions
• All windows accessing the data files used for the current window are closed.

• The current analysis results are not saved.
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3.8 View > Measured Data

Functions
• Filters are applied to raw data according to the filter settings, and a crank angle graph

is displayed.
• The following are displayed depending on the command used.

View > Measured data > Raw data: Raw data before TDC correction

View > Measured data > Corrected data: Raw data after TDC correction
• The data name, cycle range, and angular resolution is displayed in the title bar of the

window.

• Shows the displayed channels, displayed cycles, and the current filter settings.
• When filter settings are entered, the display is updated.
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3.9 View > Crank Angle Graph

Functions
• Displays a crank angle graph of the combustion pressure analysis results.

• The selected values from the cycle graph data items and the measurement items set
to Use in Calculations in the Parameter Settings screen are displayed in the lower
right portion of the screen.

The following shows how the displayed contents varies depending on the settings for
displayed channels and displayed cycles (see section 3.1, “Common Operations”).

Display Channels Cycles Displayed Value

Specified channel Specified cycle Value for specified cycles

AVE Same values as in the numeric analysis data item
screen

ALL None

ALL - None
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If you select “3D” on the Graph Dimension Settings screen (see section 3.1, “Common
Operations”), the following 3D display appears.

Functions
• Crank angle display data is extracted each number of specified cycles from the

specified range of cycles, and a 3D graph is displayed.

• The maximum number of cycles that can be displayed is 20.

Setting/Display Data

No. Item Default Setting Data Size Numerical Data Input (I) or
Type Min. Value Max. Value Select (S)

1 Range of Cycles Extracted cycles I 3 1 800 I

3.9  View > Crank Angle Graph
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3.10 View > Cycle Graph

Functions
• Displays a cycle graph of the combustion pressure analysis results.

• The average values (the same values displayed in the numeric analysis data items
screen) of the selected cycle graph data items and the measurement items set to Use
in Calculations in the Parameter Settings screen are displayed in the lower part of the

screen.
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3.11 View > Numeric Analysis Data Items

Functions
• Displays the numeric analysis data items of the combustion pressure analysis results.
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3.12 Settings > Filter

Functions
• You can perform digital filter processing on raw data.  If the raw or corrected data has

already been displayed, filters are automatically applied and the display is updated.

However, this does not affect current analysis results.  All calculated results are
cleared, and any currently displayed analysis results windows are closed.  Display
analysis results windows again after calculations have been performed.

• You can select None, Lowpass, Bandpass, or Highpass filters.
• The filter function is a 4th order Butterworth (24 db/oct).
• The cutoff frequency is set in numbers of orders (multiples) since data acquisition

uses synchronization with the rotation pulse.
• When filters are applied, any TDC correction and combustion pressure analysis

performed thereafter is done on filtered data.

Setting/Display Data

No. Item Default Setting Data Size Numerical Data Input (I) or
Type Min. Value Max. Value Select (S)

1 Filter type Prev. value - - - - S

2 Cutoff Prev. value F 6.1 7.2 720 I

(1) Filter type : Select None, Lowpass, Bandpass, or Highpass for the filter.
(2) Cutoff: The cutoff can be set in the following ranges:

At 1 CA resolution, 7.2 order (times) to 72 order (times) of the number of

revolutions
At 0.5 CA resolution, 14.4 order (times) to 144 order (times) of the number of
revolutions

At 0.25 CA resolution, 28.8 order (times) to 288 order (times) of the number of
revolutions
At 0.1 CA resolution, 72 order (times) to 720 order (times) of the number of

revolutions

Button Operations
OK Button

Activates filters conditions, applies filters to raw data, and closes the window.
Cancel Button

Clears all on-screen settings, and closes the window.



3-17IM 707765-61E

S
creen

s an
d

 O
p

eratio
n

s

3

3.13 Settings > TDC Correction and Calibration
Factor Settings

Functions
• The TDC correction value can be calculated using one cycle’s worth of all-cycle-

averaged motoring data from cylinder 1 (P1).

The calculated TDC correction value is added to the difference in angle between
cylinders according to the specified number of cylinders (for example at 4 cycles and
4 cylinders) in the following manner: 0 + calculated TDC correction value, 180 +

calculated TDC correction value, 360 + calculated TDC correction value, 540 +
calculated TDC correction value, then the cylinder-to-cylinder TDC correction value is
automatically set.

You can also set the cylinder-to-cylinder TDC correction values manually (excluding
P1).

• Signal assignments can be entered.

You can assign channels to cylinder pressure (up to eight cylinder's worth), intake
manifold pressure, intake manifold temperature, fuel consumption, revolutions per
minute, and other signals.

• The cylinder pressure signals undergo TDC correction per the specified TDC
correction value.

• Cylinder pressure measurements take place in the cylinder’s firing order, with the

assumption that all signals are assigned to contiguous channels starting with channel
1.

• You can specify channels to be excluded from combustion pressure analysis.

• If the raw or corrected data has already been displayed, settings are automatically
applied and the display is updated.  However, this does not affect current analysis
results.  When changing these settings, all previously calculated results are cleared,

and any currently displayed analysis results windows are closed.  Display analysis
results windows again after calculations have been performed.
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Setting/Display Data

No. Item Default Setting Data Size Numerical Data Input (I) or
Type Min. Value Max. Value Select (S)

1 Calculated TDC Correction Value Calculated value F 7.2 (*1) (*2) I

2 Number of Cylinders Prev. value I 2.0 1 8 S

3 Cylinder-to-cylinder Calculated value F 7.2 (*1) (*3) I
TDC Correction

4 Unused None - - - - S

5 Channel Name None - - - - S

6 Interval of Absolute Pressure Prev. value F 7.2 (*1) (*2) I
Correction

7 A Prev. value F 8.2 1 99999.99 I

8 B Prev. value F 8.2 1 99999.99 I

*1: 4 cycles = −360; 2 cycles = −180
*2: 4 cycles = −359.9; 2 cycles = −179.9
*3: 4 cycles = −1079.9; 2 cycles = −539.9

(1) Calculated TDC Correction Value: Displays the TDC correction values
calculated using the average of all cycles of the first cylinder (P1).  The value
can also be entered manually.  When the OK button is used, this value is

rounded to the angular resolution and applied to each channel.
(2) Number of Cylinders: Specified for automatic calculation of the cylinder-to-

cylinder correction value.  If the value is changed, click the Calculate button to

recalculate the results.
(3) Cylinder-to-cylinder TDC Correction: The calculated TDC correction value is

added to the difference in the crank angle.  For example, with a 4-cycle engine:

4 cylinders = 180 CA, 6 cylinders = 120 CA, and 8 cylinders = 90 CA. You can
also set the value manually (excluding P1).

(4) Unused: Selected channels are ignored during analysis.  CSV files are also not
saved.

(5) Channel Names: Signals are assigned to channels 1 through 16. Select the
signal type from the options below.

P1 to P8: Cylinder pressure in the order of firing

Pitk: Intake manifold pressure
FC: Fuel consumption
Ne: Revolutions per minute

Td: Intake manifold temperature
EXTo2: Concentration of oxygen remaining in exhaust gas
Other: Other Signals

For signals other than P1 through P8, TDC correction is performed based on the
1st cylinder.
This measured data can be used when measuring intake manifold pressure, fuel

consumption, revolutions per minute, and intake manifold temperature, and
performing analysis.  The average value at each cycle can be saved to a .csv file.
Other signals can be displayed in a crank angle graph or cycle graph, and that

graphical data can be saved in CSV format.
(6) A, B: The measured voltage signals are converted to physical values using the

equation y = Ax + B.

Button Operations
OK Button

Activates all on-screen settings, and closes the window.
Cancel Button

Clears all on-screen settings, and closes the window.

3.13  Settings > TDC Correction and Calibration Factor Settings
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3.14 Calculation > Set Parameters

Functions
• Lets you enter necessary engine and other parameters for combustion pressure

analysis.
• You can select either Clearance volume or Compression ratio.
• Enter the number of data from which to determine the start and end of combustion.

Or, enter the combustion start and end values directly.
• Specify the range for searching for the maximum rate of heat release.
• Select the method of absolute pressure correction.

• Select whether or not to use this measured data for analysis when measuring intake
manifold pressure, fuel consumption, revolutions per minute, intake manifold
temperature, and concentration of oxygen remaining in exhaust gas.

• When changing these settings, all previously calculated results are cleared, and any
currently displayed analysis results windows are closed.  Display analysis results
windows again after calculations have been performed.
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Setting/Display Data

No. Item Unit Default Setting Data Size Numerical Data Input (I) or
Type Min. Value Max. Value Select (S)

1 Con-rod Length mm Prev. value F 9.3 0.000 99999.999 I

2 Bore mm Prev. value F 9.3 0.000 99999.999 I

3 Piston offset mm Prev. value F 9.3 0.000 99999.999 I

4 Stroke mm Prev. value F 9.3 0.000 99999.999 I

5 Clearance volume cm3 Prev. value F 9.3 0.000 99999.999 I or S

6 Compression ratio - Prev. value F 6.3 0.000 99999.999 I or S

7 Composition ratio of % Prev. value F 6.2 0 100.00 I
methane

8 Composition ratio of ethane % Prev. value F 6.2 0 100.00 I

9 Composition ratio of propane % Prev. value F 6.2 0 100.00 I

10 Composition ratio of % Prev. value F 6.2 0 100.00 I
isobutane

11 Composition ratio of % Prev. value F 6.2 0 100.00 I
n-butane

12 Concentration of oxygen % Prev. value F 6.2 0 100.00 I
remaining in exhaust gas(%)

13 Measured concentration of - - - - - - S
oxygen remaining
in exhaust gas

14 Fuel consumption m3/h Prev. value F 9.3 0.000 99999.999 I or S

15 Measured fuel consumption - - - - - - S

16 Atmospheric temperature °C Prev. value F 9.3 –273.000 99999.999 I or S

17 Measured intake manifold - - - - - - S
temperature

18 Atmospheric pressure kPa Prev. value F 9.3 0.000 99999.999 I or S

19 Measured intake manifold - - - - - - S
pressure

20 Revolutions per minute rpm Prev. value I 5.0 0 99999 I or S

21 Measured revolutions - - - - - - S
per minute

22 Number of cylinders - Prev. value I 1.0 1 8 I

23 Engine power kW Prev. value F 9.3 0 99999.999 I

24 Boost pressure kPa Prev. value F 7.3 0.000 999.999 I

25 True heat release of gas fuel J Prev. value F 9.3 0.000 999999999.9 I or S

26 Start point of combustion CA Prev. value F 6.2 −360.00 359.99 I

27 Number of data items for - Prev. value I 2.0 3 99 I
judging start point of
combustion

28 End point of combustion CA Prev. value F 6.2 −360.00 359.99 I

29 Number of data items for - Prev. value I 2.0 3 99 I
judging end point of
combustion

30 Method of absolute - - - - - - S
pressure correction

31 Window of searching CA Prev. value F 6.2 −360.00 359.99 I
maximum rate of heat
release

32 Ratio for judging angle of % Prev. value I 2.0 5 95 I
combustion mass rate

33 Value for judging misfire kPa Prev. value F 9.3 0.000 99999.999 I

(1) Start point of combustion: The specified value (without searching).
(2) End point of combustion: The specified value (without searching).

3.14  Calculation > Set Parameters
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(3) Window of searching maximum rate of heat release: Set the range for
finding the maximum angle of the rate of heat release used as the standard for

searching for the start and end points of combustion.
(4) Ratio for judging angle of combustion mass rate:  Determines the crank

angle at which the combustion mass rate matches the specified percentage.

(5) Value for judging misfire: Cycles for which the IMEP is lower than this setting
are judged as misfires, and the rate of misfire is determined by the ratio of the
number of misfiring cycles relative to the total number of cycles.

(6) Measured concentration of oxygen remaining in exhaust gas: Select this
item when measuring the concentration of oxygen remaining in exhaust gas and
using the result for calculations.  In the TDC Correction and Calibration Factor

Setting screen, it is assumed that concentration of oxygen remaining in exhaust
gas (EXTo2) is assigned to a channel.

(7) Measured fuel consumption: Select this item when measuring the fuel

consumption and using the result for calculations.  In the TDC Correction and
Calibration Factor Setting screen, it is assumed that fuel consumption (Fc) is
assigned to a channel.

(8) Measured intake manifold temperature: Select this item when measuring the
temperature of the intake manifold and using the result for calculations.   In the
TDC Correction and Calibration Factor Setting screen, it is assumed that fuel

consumption(Td) is assigned to a channel.
(9) Measured intake manifold pressure: Select this item when measuring the

pressure in the intake manifold and using the result for calculations. In the TDC

Correction and Calibration Factor Setting screen, it is assumed that intake
manifold pressure (Pitk) is assigned to a channel.

(10) Measured revolutions per minute: Select this item when measuring rpm's and

using the result for calculations. In the TDC Correction and Calibration Factor
Setting screen, it is assumed that rpm (Ne) is assigned to a channel.

Button Operations
OK Button

Activates all on-screen settings and closes the window.  The settings take effect for

the next calculation.
Cancel Button

Clears all on-screen settings, and closes the window.

3.14  Calculation > Set Parameters
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3.15 Calculation > Calculate

Functions
• You can select items to undergo combustion pressure analysis, then execute the

analysis.  Cylinder pressure and rate of cylinder pressure rise are always analyzed.
• The progress of the combustion pressure calculation is shown by the filling in of each

check box.   If a particular calculation is impossible, the item is skipped and the

software advances to the next item.

Button Operations
Calculate Button:

Calculates the selected analysis items (including related calculations).
Close Button:

This button appears when calculation ends.  Closes the window.
Cancel Button

This button disappears when calculation is started.

Closes the window.
Stop Button

Stops calculation.

Select All Button
Selects all items for analysis.
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3.16 Graph

Functions
• These are the same functions as the ones described in section 3.1, “Common

Operations.”
They include graph dimension settings, axis settings, displayed channels, displayed
cycles, and graph color settings.
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3.17 Window > Cascade

Functions
• Arranges all open windows in a cascading fashion.
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3.18 Window > Tile

Functions
• Arranges all open windows in a non-overlapping fashion.
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3.19 Window > Arrange Icons

Functions
• Arranges minimized icons.
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3.20 Window > Minimize

Functions
• Minimizes all windows accessing the same data.

• Minimizes all monitor function windows.
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3.21 Window > Restore

Functions
• Restores all minimized windows that were accessing the same data.

• Restores all minimized monitor function windows.
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Chapter 4 CSV Files

4.1 Saved Items

Test Information, Manually Input Data Items
• Test Information

Test date
Data name
Testing personnel

Department
Test name
Engine type

Serial No.
Place of test
Test bench type

Comments

• Manually Input Data Items
Calculated TDC correction value (CA)
Number of cylinders
Channel-by-channel TDC correction value (CA)

Channel-by-channel calibration factor A (kPa/V)
Channel-by-channel calibration factor B (kPa/V)
Channel-by-channel used/unused (1: Used)

Starting angle of correction interval (CA)
Ending angle of correction interval (CA)
Channel name

Con-rod length (m)
Bore (m)
Piston offset (m)

Stroke length (m)
Clearance volume (m3)
Compression ratio

Composition ratio of methane (%)
Composition ratio of ethane (%)
Composition ratio of propane (%)

Composition ratio of isobutane (%)
Composition ratio of n-butane (%)
Concentration of oxygen remaining in exhaust gas (%)

Fuel Consumption (m3/h)
Atmospheric Temperature (°C)
Atmospheric pressure (kPa)

Revolutions per minute (rpm)
Number of cylinders
Engine power (kW)

Boost pressure (kPa)
True heat release of gas fuel (J/m3)
Method of absolute pressure correction

Angle for start point of combustion (point a) (CA)
Number of data items for judging start point of combustion
Angle for end point of combustion (point b) (CA)

Number of data items for judging end point of combustion
Start point of searching maximum rate of heat release (CA)



4-2 IM 707765-61E

End point of searching maximum rate of heat release (CA)
Ratio for judging angle of combustion mass rate N1 (%)

Ratio for judging angle of combustion mass rate N2 (%)
Ratio for judging angle of combustion mass rate N3 (%)
Value for judging misfire (kPa)

Calculation Results
• Calculation Data Items: Numeric Analysis Data

Average cylinder pressure across correction interval (kPa)
Averaged maximum cylinder pressure (kPa)
Standard deviation of maximum cylinder pressure (kPa)

Rate of change in maximum cylinder pressure (%)
Averaged maximum rate of cylinder pressure rise (kPa/deg)
Standard deviation of maximum rate of cylinder pressure rise (kPa/deg)

Rate of change in maximum rate of cylinder pressure rise (%)
Piston displacement (m3)
Averaged NMEP (kPa)

Standard deviation of NMEP (kPa)
Rate of change in NMEP (%)
Averaged IMEP (kPa)

Standard deviation of IMEP (kPa)
Rate of change in IMEP (%)
Averaged PMEP (kPa)

Standard deviation of PMEP (kPa)
Rate of change in PMEP (%)
Averaged maximum cylinder gas temperature (°C)

Standard deviation of maximum cylinder gas temperature (°C)
Rate of change in maximum cylinder gas temperature (%)
Averaged maximum rate of heat release (J/deg)

Standard deviation of maximum rate of heat release (J/deg)
Rate of change in maximum rate of heat release (%)
Averaged maximum amount of heat release (J)

Standard deviation of maximum amount of heat release (J)
Rate of change in maximum amount of heat release (%)
Averaged angle at combustion mass rate N1 % (CA)

Standard deviation of angle at combustion mass rate N1 % (CA)
Rate of change in angle at combustion mass rate N1 % (%)
Averaged angle at combustion mass rate N2 % (CA)

Standard deviation of angle at combustion mass rate N2 % (CA)
Rate of change in angle at combustion mass rate N2 % (%)
Averaged angle at combustion mass rate N3 % (CA)

Standard deviation of angle at combustion mass rate N3 % (CA)
Rate of change in angle at combustion mass rate N3 % (%)
Average start point of combustion (point a) (CA)

Average end point of combustion (point b) (CA)
Minimum value of IMEP (kPa)
LNV of  IMEP (%)

Rate of misfire (%)
Averaged maximum cylinder pressure of all cycles and cylinders (kPa)
Averaged maximum rate of cylinder pressure rise of all cycles and cylinders (kPa/deg)

Averaged NMEP of all cycles and cylinders (kPa)

4.1  Saved Items



4-3IM 707765-61E

C
S

V
 F

iles

4

Averaged IMEP of all cycles and cylinders (kPa)
Averaged PMEP of all cycles and cylinders (kPa)

Minimum IMEP of all cycles and cylinders (kPa)
LNV of IMEP of all cycles and cylinders (%)
Oxygen requirement (m3)

Exhaust gas volume (m3)
Theoretical air (m3)
Theoretical exhaust gas volume (m3)

Amount of water produced (m3)
Theoretical volume of dry exhaust gas (m3)
Excess air factor (m3)

Intake air volume (m3/h)
Intake fuel-air mixture volume (m3/h)
Volumetric efficiency (%)

Specific gravity of fuel gas
Mass of intake air (kg)
Mass of intake fuel (kg)

Mass of intake gas mixture (kg)
Gas mixture constant (J/kg.K)
True heat release of gas fuel (J/m3)

Cooling loss (J)
Cooling loss ratio (%)
Brake thermal efficiency (%)

Friction loss (%)
Combustion efficiency (%)
Degree of constant volume

Indicated efficiency (%)

• Calculation Data Items: Crank Angle Graph Data Items
Crank angle
Average cylinder pressure (kPa)
Logarithmic average cylinder pressure (kPa)

Piston displacement (m)
Rate of cylinder volume increase (m3/deg)
Piston displacement (m3)

Logarithmic cylinder volume (m3)
Average rate of cylinder pressure rise (kPa/deg)
Average cylinder gas temperature (°C)

Average rate of heat release (J/deg)
Average amount of heat release (J)
Average combustion mass rate (%)

Raito of specific heat
Polytropic index

4.1  Saved Items
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• Calculation Data Items: Cycle Graph Data Items
Cycle

Maximum cylinder pressure (kPa)
Crank angle at maximum cylinder pressure (CA)
Averaged maximum cylinder pressure of all cylinders (kPa)

Averaged crank angle at maximum cylinder pressure of all cylinders (CA)
Maximum rate of cylinder pressure rise (kPa/deg)
Crank angle at maximum rate of cylinder pressure rise (CA)

Averaged maximum rate of cylinder pressure rise of all cylinders (kPa/deg)
Averaged angle at maximum rate of cylinder pressure rise of all cylinders (CA)
Compression/expansion work (J)

Pumping loss (J)
NMEP (kPa)
Averaged NMEP of all cylinders (kPa)

IMEP (kPa)
Averaged IMEP of all cylinders (kPa)
PMEP (kPa)

Averaged PMEP of all cylinders (kPa)
Maximum cylinder gas temperature (°C)
Crank angle at maximum cylinder gas temperature (CA)

Maximum rate of heat release (J/deg)
Crank angle at maximum rate of heat release (CA)
Maximum amount of heat release (J)

Crank angle at maximum amount of heat release (CA)
Angle at combustion mass rate N1 % (CA)
Angle at combustion mass rate N2 % (CA)

Angle at combustion mass rate N3 % (CA)
Start point of combustion (point a) (CA)
End point of combustion (point b) (CA)

* When carrying out a per-cycle absolute pressure correction, the per-cycle absolute pressure

correction value are left in the Calculation Item: Cycle Graph Data field.

• Calculation Data Items: Crank Angle Graph Data (Other Signals)
Crank angle

Intake manifold pressure (kPa)
Fuel consumption (m3/h)
Revolutions per minute (rpm)

Intake manifold temperature (°C)
Concentration of oxygen remaining in exhaust gas (%)
Other signals (Crank angle graph data)

• Calculation Data Items: Cycle Graph Data Items (Other Signals)
Cycle

Intake manifold pressure (kPa)
Fuel consumption (m3/h)
Revolutions per minute (rpm)

Intake manifold temperature (°C)
Concentration of oxygen remaining in exhaust gas (%)
Other signals (Cycle graph data)

4.1  Saved Items
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Crank Angle Graph Data of Specified Range of Cycles
Crank angle

Cylinder pressure (kPa)
Rate of cylinder pressure rise (kPa/deg)
Cylinder gas temperature (°C)

Rate of heat release (J/deg)
Amount of heat release (J)
Combustion mass rate (%)

Ratio of specific heat
Intake manifold pressure (kPa)
Fuel consumption (m3/h)

Revolutions per minute (rpm)
Intake manifold temperature (°C)
Concentration of oxygen remaining in exhaust gas (%)

Other signals (Crank angle graph data)

* Intake manifold pressure, fuel consumption, rpm, intake manifold temperature, and

concentration of oxygen remaining in exhaust gas are saved only when they are measured.

4.1  Saved Items
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Chapter 5 Equations

5.1 Explanation of Equations

In the explanations below, 720 indicates the angle at cycle 1 for a 4-cycle engine.
Substitute 360 for a 2-cycle engine.

1. Pθ in
Cylinder pressure (kPa) of the specified range of cycles extracted after rotational offset
correction and TDC correction

Pθ in = A × U[720,N] + B

N: Number of cycles
U: Voltage value (measured value) of the specified range of cycles

extracted after rotational offset correction and TDC correction (V)
A, B: Sensor calibration factor (kPa/V) (manually input)

2. Padj[N]
Average cylinder pressure (kPa) of the specified crank angle range used for the absolute

pressure correction

For per-cycle average

Padj[N] = ave(Pθ in[θ = adj θ1 to adj θ2,N]) # ave: average value
For all-cycle average
Padj[N] = ave(Pθ in_ave[θ = adj θ1 to adj θ2]) # ave: average value

N: Number of cycles
Pθ in: Cylinder pressure (kPa) (calculated value) of the specified range of

cycles extracted after rotational offset correction and TDC correction
Pθ in_ave: Average cylinder pressure (kPa) (calculated value)

Pθ in_ave[720] = (1 / N) × Σ(Pθ in[720,N])
adj θ1: Starting angle (CA) of the range used for absolute pressure correction

(manually input)
adj θ2: Ending angle (CA) of the range used for absolute pressure correction

(manually input)

3. Pitk_ave[N]
Average intake manifold pressure at each cycle (kPa)

When intake manifold pressure is set to be measured and used in calculations:
Pitk_ave[N] = ave(Pθ itk[720,N]) # ave: average value

N: Number of cycles
Pθ itk: Intake manifold pressure (kPa) (measured value)

4. Pθ [720, N]
Cylinder pressure after absolute pressure correction (kPa)

• When the atmospheric and boost pressures are manually input,
Pθ [720,N] = Pθ in[720, N] – Padj[N] + Pa + Pt

• When depending on the measured intake manifold pressure,
Pθ [720,N] = Pθ in[720,N] – Padj[N] + Pitk_ave [N]

N: Number of cycles
Pθ in: Cylinder pressure (kPa) after rotational offset correction and TDC

correction (calculated value)
Padj: Average cylinder pressure across correction interval (kPa) (calculated

value)
Pa: Atmospheric pressure (kPa) (manually input)
Pt: Boost pressure (kPa) (manually input)
Pitk_ave: Average intake manifold pressure (kPa) (calculated value)
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5. logPθ [720, N]
Logarithmic cylinder pressure (kPa)

logPθ [720,N] = log10(Pθ [720,N])

N: Number of cycles

Pθ : Cylinder pressure (kPa) after absolute pressure correction (calculated
value)

6. Pθ ave[720]
Average cylinder pressure (kPa)

Pθ ave[720] = (1 / N) × Σ(Pθ[720,N])

N: Number of cycles
Pθ: Cylinder pressure (kPa) after absolute pressure correction (calculated

value)

7. logPθ ave[720]
Logarithmic average cylinder pressure (kPa)

logPθ ave[720] = log10(Pθ ave[720])

Pθ ave: Average cylinder pressure (kPa) (calculated value)

8. Xθ [720]
Piston displacement (m)

R = S / 2
φ = arcsin(γ / ( L+R))

Xθ [720] = sqrt ((R+L)2 – γ2) – R × cos((θ + α) × ( pi / 180) + φ)
– sqrt(L2 – (–R × sin((φ +α) × (pi / 180) + φ) + γ)2) # sqrt: quare root

S: Stroke length (m) (manually input)
L: Con-rod length (m) (manually input)
γ: Piston offset (m) (manually input)

θ: Crank angle (CA) radian
4-cycle engine: –360 to +359 CA: at 1 CA resolution
2-cycle engine: –180 to +179 CA: at 1 CA resolution

α: The numbers to the right of the decimal of the TDC correction value
(CA) (calculated or manually input).  In other words, given an angular
resolution of 1 CA, the value is (θ +α) = 0+α, 1+α, . . .

pi: The circular constant

γ

L

S/2

BDC

TDC

S
φ

5.1  Explanation of Equations
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9. Vθ [720]
Piston displacement (m3)

When Clearance volume is selected on the Parameter Settings screen
Vθ [720] = (pi / 4) × B2 × Xθ [720] + Vc
When Compression ratio is selected on the Parameter Settings screen

Vθ [720] = (pi / 4) × B2 × Xθ [720] + Vst / (Cr–1)

pi: The circular constant

B: Bore (m) (manually input)
Xθ: Piston displacement (m) (calculated value)
Vc: Clearance volume (m3) (manually input)

Vst: Piston displacement (m3) (calculated value)
Cr: Compression ratio (manually input)

10. dVθ [720]
Rate of piston displacement increase (m3/deg)

dVθ [720] = (Vθn-2 – 8 × Vθn-1 + 8 × Vθn+1 – Vθn+2) / (12 × res)

When the angular resolution is 1 CA, the calculation is made as shown below.
When n = 1 or 2, (Vθn-2, Vθn-1) = (Vθ719, Pθ720) or (Vθ720, Vθ001)
When n = 719 or 720, (Vθn+1, Vθn+2) = (Vθ720, Vθ001) or (Vθ001, Vθ002)

Vθ: Piston displacement (m3) (calculated value)
res: Angular resolution (1, 0.5, 0.25, or 0.1 CA)

11. logVθ [720]
Logarithmic piston displacement (m3)

logVθ [720] = log10(Vθ [720])

Vθ : Piston displacement (m3) (calculated value)

12. dPθ [720,N]
Rate of cylinder pressure rise (kPa/deg)

dPθ [720, N] = (Pθn-2 – 8 × Pθn-1 + 8 × Pθn+1 – Pθn+2) / (12 × res)
When the resolution is 1 CA, the calculation is made as shown below.

When n = 1 or 2, (Pθn–2, Pθn–1) = (Pθ001, Pθ001)

When n = 719 or 720, (Pθn+1, Pθn+2) = (Pθ720, Pθ720)

N: Number of cycles

Pθ: Cylinder pressure (kPa) after absolute pressure correction (calculated
value)

res: Angular resolution (1, 0.5, 0.25, or 0.1 CA)

13. dPθ ave [720]
Average rate of cylinder pressure rise (kPa/deg)

dPθ ave[720] = (1 / N) × Σ(dPθ in[720,N])

N : Number of cycles

dPθ : Rate of cylinder pressure rise (kPa/deg) (calculated value)

5.1  Explanation of Equations
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14. Pmax[N]
Maximum cylinder pressure (kPa)

Pmax[N] = max(Pθ [720,N]) # max: maximum value

N : Number of cycles

Pθ : Cylinder pressure (kPa) (calculated value)

15. θPmax [N]
Crank angle at maximum cylinder pressure (CA)

θPmax[N] = pos(Pθ [720,N]) # pos: crank angle at max. cylinder pressure

N : Number of cycles
Pθ : Cylinder pressure (kPa) (calculated value)

16. θPmax_ave
Averaged crank angle at maximum cylinder pressure (CA)

θPmax_ave = (1 / N) × Σ(θPmax [N])

N : Number of cycles
θPmax : Crank angle at maximum cylinder pressure (CA) (calculated value)

17. Pmax_ave
Averaged maximum cylinder pressure (kPa)

Pmax_ave = (1 / N) × Σ(Pmax [N])

N : Number of cycles

Pmax : Maximum cylinder pressure (kPa) (calculated value)

18. Pmax_std
Standard deviation of maximum cylinder pressure (kPa)

Pmax_std = sqrt((1 / (N–1)) × Σ(Pmax [N] – Pmax_ave)2) # sqrt: square root

N : Number of cycles
Pmax : Maximum cylinder pressure (kPa) (calculated value)
Pmax_ave : Averaged maximum cylinder pressure (kPa) (calculated value)

19. Pmax_cov
Rate of change (%) in maximum cylinder pressure

Pmax_cov = (Pmax_std / Pmax_ave) × 100

Pmax_std : Standard deviation of the max. cylinder pressure (kPa) (calculated

value)
Pmax_ave : Averaged max. cylinder pressure (kPa) (calculated value)

20. Pmax_Cy[N]
Averaged maximum cylinder pressure of all cylinders (kPa)

Pmax_Cy[N] = (1 / Cy) × Σ(Pmax [Cy, N])

Cy : Number of cylinders
N: Number of cycles

Pmax : Maximum cylinder pressure (kPa) (calculated value)

5.1  Explanation of Equations
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21. Pmax_Cy_ave
Averaged maximum cylinder pressure of all cycles and cylinders (kPa)

Pmax_Cy_ave = (1 / N) × Σ(Pmax_Cy [N])

N : Number of cycles

Pmax_Cy : Averaged maximum cylinder pressure of all cylinders (kPa) (calculated
value)

22. θPmax_Cy [N]
Averaged crank angle at maximum cylinder pressure of all cylinders (CA)

θPmax_Cy[N] = (1 / Cy) × Σ(θPmax [Cy, N])

Cy: Number of cylinders
N : Number of cycles

θPmax : Crank angle at maximum cylinder pressure (CA) (calculated value)

23. θPmax_Cy_ave
Averaged crank angle at maximum cylinder pressure of all cycles and cylinders (CA)

θPmax_Cy_ave = (1 / N) × Σ(θPmax_Cy [N])

N : Number of cycles
θPmax_Cy : Averaged crank angle at maximum cylinder pressure of all cylinders

(CA) (calculated value)

24. dPmax[N]
Maximum rate of cylinder pressure rise (kPa/deg)

dPmax[N] = max(dPθ [720,N]) # max: maximum value

N : Number of cycles

dPθ : Rate of cylinder pressure rise (kPa/deg) (calculated value)

25. θdPmax[N]
Crank angle at maximum rate of cylinder pressure rise (CA)

θdPmax[N] = pos(dPθ [720,N])
# pos: crank angle at the maximum rate of cylinder pressure rise

N : Number of cycles
dPθ : Rate of cylinder pressure rise (kPa/deg) (calculated value)

26. θdPmax_ave
Averaged crank angle at maximum rate of cylinder pressure rise (CA)

θdPmax_ave = (1 / N) × Σ(θdPmax [N])

N : Number of cycles

dPθmax : Crank angle at maximum rate of cylinder pressure rise (CA) (calculated
value)

5.1  Explanation of Equations
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27. dPmax_ave
Averaged maximum rate of cylinder pressure rise (kPa/deg)

dPmax_ave = (1 / N) × Σ(dPmax [N])

N: Number of cycles

dPmax : Maximum rate of cylinder pressure rise (kPa/deg) (calculated value)

28. dPmax_std
Standard deviation of maximum rate of cylinder pressure rise (kPa/deg)

dPmax_std = sqrt((1 / (N–1)) × Σ(dPmax [N] – dPmax_ave)2) # sqrt: square root

N: Number of cycles
dPmax : Maximum rate of cylinder pressure rise (kPa/deg) (calculated value)
dPmax_ave : Averaged maximum rate of cylinder pressure rise (kPa/deg) (calculated

value)

29. dPmax_cov
Rate of change (%) in maximum cylinder pressure rise

dPmax_cov = (dPmax_std / dPmax_ave) × 100

dPmax_std : Standard deviation of maximum rate of cylinder pressure rise (kPa/deg)
(calculated value)

dPmax_ave : Averaged maximum rate of cylinder pressure rise (kPa/deg) (calculated

value)

30. dPmax_Cy[N]
Averaged maximum rate of cylinder pressure rise of all cylinders (kPa/deg)

dPmax_Cy[N] = (1 / Cy) × Σ(dPmax [Cy, N])

Cy : Number of cylinders
N: Number of cycles
dPmax : Maximum rate of cylinder pressure rise (kPa/deg) (calculated value)

31. dPmax_Cy_ave
Averaged maximum rate of cylinder pressure rise of all cycles and cylinders (kPa/deg)

dPmax_Cy_ave = (1 / N) × Σ(dPmax_Cy [N])

N : Number of cycles

dPmax_Cy : Averaged maximum rate of cylinder pressure rise of all cylinders (kPa/
deg) (calculated value)

32. θdPmax_Cy [N]
Averaged crank angle at maximum rate of cylinder pressure rise of all cylinders (CA)

θdPmax_Cy[N] = (1 / Cy) × Σ(θdPmax [Cy, N])

Cy: Number of cylinders
N : Number of cycles

θdPmax : Crank angle at maximum rate of cylinder pressure rise (CA) (calculated
value)

5.1  Explanation of Equations
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33. θdPmax_Cy_ave
Averaged crank angle at maximum rate of cylinder pressure rise of all cycles and

cylinders (CA)

θdPmax_Cy_ave = (1 / N) × Σ(θdPmax_Cy [N])

N : Number of cycles
θdPmax_Cy : Averaged crank angle at maximum rate of cylinder pressure rise of all

cylinders (CA) (calculated value)

34. Wpower [N]
Compression/expansion work (J)

∆V = abs(Vθi – Vθi+1) # abs: absolute value
A[N] = Σ (0.5 × (Pθi + Pθi+1) × 1000.0 × ∆V) θ = –180 to –1
B[N] = Σ (0.5 × (Pθi + Pθi+1) × 1000.0 × ∆V) θ = 0 to 179

Wpower[N] = B[N] – A[N]
For a 2-cycle engine, when θ = 179, Pθi+1 is Pθi, and Vθi+1 is Vθ–180.

N : Number of cycles
Vθ : Piston displacement (m3) (calculated value)
Pθ : Cylinder pressure (kPa) after absolute pressure correction (calculated

value)

35. Wpump[N]
Pumping loss (J)

∆V = abs(Vθi – Vθi+1) # abs: absolute value
C[N] = Σ (0.5 × (Pθi + Pθi+1) × 1000.0 × ∆V) θ = 180 to 359

D[N] = Σ (0.5 × (Pθi + Pθi+1) × 1000.0 × ∆V) θ = –360 to –181
Wpump[N] = C[N] – D[N]
When θ = 359, Pθi+1 is Pθi, and Vθi+1 is Vθ –360.

Wpump[N] is zero for 2-cycle engines.

N : Number of cycles

Vθ : Piston displacement (m3) (calculated value)
Pθ : Cylinder pressure (kPa) after absolute pressure correction (calculated

value)

36. Vst
Piston displacement (m3)

Vst = (pi / 4) × B2 × S

pi : The circular constant

B : Bore (m) (manually input)
S : Stroke length (m) (manually input)

37. NMEP[N]
NMEP (kPa)

NMEP[N] = (Wpower [N] / 1000.0 – Wpump[N] / 1000.0) / Vst

N : Number of cycles
Wpower : Compression/expansion work (J) (calculated value)

Wpump : Pumping loss (J) (calculated value)
Vst : Piston displacement (m3) (calculated value)

5.1  Explanation of Equations
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38. NMEP_ave
Averaged NMEP (kPa)

NMEP_ave = (1 / N) × Σ(NMEP [N])

N : Number of cycles

NMEP : NMEP (kPa) (calculated value)

39. NMEP_std
Standard deviation of NMEP (kPa)

NMEP_std = sqrt((1 / (N–1)) × Σ(NMEP [N] – NMEP_ave)2) # sqrt: square root

N : Number of cycles
NMEP : NMEP (kPa) (calculated value)
NMEP_ave : Averaged NMEP (kPa) (calculated value)

40. NMEP_cov
Rate of change in NMEP (%)

NMEP_cov = (NMEP_std / NMEP_ave) × 100

NMEP_std : Standard deviation of NMEP (kPa) (calculated value)

NMEP_ave : Averaged NMEP (kPa) (calculated value)

41. NMEP_Cy[N]
Averaged NMEP of all cylinders (kPa)

NMEP_Cy[N] = (1 / Cy) × Σ(NMEP [Cy, N])

Cy: Number of cylinders
N : Number of cycles
NMEP : NMEP (kPa) (calculated value)

42. NMEP_Cy_ave
Averaged NMEP of all cycles and cylinders (kPa)

NMEP_Cy_ave = (1 / N) × Σ(NMEP_Cy [N])

N : Number of cycles

NMEP_Cy : Averaged NMEP of all cylinders (kPa) (calculated value)

43. IMEP[N]
IMEP (kPa)

IMEP[N] = (Wpower [N] / 1000.0) / Vst

N : Number of cycles
Wpower : Compression/expansion work (J) (calculated value)
Vst : Piston displacement (m3) (calculated value)

44. IMEP_ave
Averaged IMEP (kPa)

IMEP_ave = (1 / N) × Σ(IMEP [N])

N : Number of cycles

IMEP : IMEP (kPa) (calculated value)

5.1  Explanation of Equations
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45. IMEP_std
Standard deviation of IMEP (kPa)

IMEP_std = sqrt((1 / (N–1)) × Σ(IMEP [N] – IMEP_ave)2) # sqrt: square root

N : Number of cycles

IMEP : IMEP (kPa) (calculated value)
IMEP_ave : Averaged IMEP (kPa) (calculated value)

46. IMEP_cov
Rate of change in IMEP (%)

IMEP_cov = (IMEP_std / IMEP_ave) × 100

IMEP_std : Standard deviation of IMEP (kPa) (calculated value)
IMEP_ave : Averaged IMEP (kPa) (calculated value)

47. IMEP_min
Minimum value of IMEP (kPa)

IMEP_min = min (IMEP[N]) # min: minimum value

N : Number of cycles

IMEP : IMEP (kPa) (calculated value)

48. IMEP_LNV
LNV of IMEP (%)

IMEP_LNV = (IMEP_min / IMEP_ave) × 100

IMEP_min : Minimum value of IMEP (kPa)
IMEP_ave : Averaged IMEP (kPa) (calculated value)

49. R_misfire
Rate of misfire (%)

R_misfire = (count(IMEP[N] < L) / N) × 100

# count: calculates the number of data that are applicable to the specified conditions

N : Number of cycles

L : Value for judging misfire (kPa) (manually input)
IMEP : IMEP (kPa) (calculated value)

50. IMEP_Cy[N]
Averaged IMEP of all cylinders (kPa)

IMEP_Cy[N] = (1 / Cy) × Σ(IMEP [Cy, N])

Cy: Number of cylinders
N : Number of cycles

NMEP : IMEP (kPa) (calculated value)

51. IMEP_Cy_ave
Averaged IMEP of all cycles and cylinders (kPa)

IMEP_Cy_ave = (1 / N) × Σ(IMEP_Cy [N])

N : Number of cycles
IMEP_Cy : Averaged IMEP of all cylinders (kPa) (calculated value)

5.1  Explanation of Equations
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52. PMEP[N]
PMEP (kPa)

PMEP[N] = ((–1 × Wpump [N]) / 1000.0) / Vst

N : Number of cycles

Wpump : Pumping loss (J) (calculated value)
Vst : Piston displacement (m3) (calculated value)

53. PMEP_ave
Averaged PMEP (kPa)

PMEP_ave = (1 / N) × Σ(PMEP [N])

N : Number of cycles
PMEP : PMEP (kPa) (calculated value)

54. PMEP_std
Standard deviation of PMEP (kPa)

PMEP_std = sqrt((1 / (N–1)) × Σ(PMEP[N] – PMEP_ave)2) # sqrt: square root

N : Number of cycles

PMEP : PMEP (kPa) (calculated value)
PMEP_ave : Averaged PMEP (kPa) (calculated value)

55. PMEP_cov
Rate of change in PMEP (%)

PMEP_cov = (PMEP_std / PMEP_ave) × 100

PMEP_std : Standard deviation of PMEP (kPa) (calculated value)
PMEP_ave : Averaged PMEP (kPa) (calculated value)

56. PMEP_Cy[N]
Averaged PMEP of all cylinders (kPa)

PMEP[N] = (1 / Cy) × Σ(IMEP [Cy, N])

Cy: Number of cylinders

N : Number of cycles
NMEP : PMEP (kPa) (calculated value)

57. PMEP_Cy_ave
Averaged PMEP of all cycles and cylinders (kPa)

PMEP_Cy_ave = (1 / N) × Σ(PMEP_Cy [N])

N : Number of cycles
PMEP_Cy : Averaged PMEP of all cylinders (kPa) (calculated value)

5.1  Explanation of Equations
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58.  Tθ [720,N]
Cylinder gas temperature (°C)

(1) Go2
Oxygen requirement (m3) per 1 m3 fuel at 0° C, 1 atomsphric pressure

Go2 = 2 × rCH4 + 3.5 × rC2H6 + 5 × rC3H8 + 6.5 × rC4H10

rCH4: Composition ratio of methane (%) (manually input)
rC2H6: Composition ratio of ethane (%) (manually input)

rC3H8: Composition ratio of propane (%) (manually input)
rC4H10: Composition ratio of butane (%) (manually input)

(= composition ratio of isobutane + composition ratio of n-butane)

(2) Gex
Exhaust gas (m3) per 1 m3 fuel at 0° C, 1 atomsphric pressure

Gex = (1 + 2) × rCH4 + (2 + 3) × rC2H6 + (3 + 4) × rC3H8 + (4 + 5) × rC4H10

rCH4: Composition ratio of methane (%) (manually input)

rC2H6: Composition ratio of ethane (%) (manually input)
rC3H8: Composition ratio of propane (%) (manually input)
rC4H10: Composition ratio of butane (%) (manually input)

(= composition ratio of isobutane + composition ratio of n-butane)

(3) Ao
Theoretical air (m3) per 1 m3 fuel at 0° C, 1 atomsphric pressure

Ao = (Go2 / 20.948) × 100

Go2: Oxygen requirement (m3) (calculated value)
20.948: Oxygen concentration (%) in the air (manually input)

(4) Go
Theoretical exhaust gas (m3) per 1 m3 fuel at 0° C, 1 atomsphric pressure

Go = ((79.052 / 100) × Ao) + Gex

79.052: Concentration of elements other than oxygen (nitrogen) in the air (%)
(manually input)

Ao: Theoretical air (m3) (at 0° C, 1 atomsphric pressure) (calculated value)
Gex: Exhaust gas (m3) (at 0° C, 1 atomsphric pressure) (calculated value)

(5) Wg
Amount of water produced (m3) per 1 m3 fuel

Wg = 2 × rCH4 +3 × rC2H6 + 4 × rC3H8 + 5 × rC4H10

rCH4: Composition ratio of methane (%) (manually input)
rC2H6: Composition ratio of ethane (%) (manually input)

rC3H8: Composition ratio of propane (%) (manually input)
rC4H10: Composition ratio of butane (%) (manually input)

(= composition ratio of isobutane + composition ratio of n-butane)

5.1  Explanation of Equations
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(6) God
Theoretical volume of dry exhaust gas (m3) per 1 m3 fuel at 0° C, 1 atomsphric pressure

God = Go − Wg

Go: Theoretical exhaust gas (m3) (at 0° C, 1 atomsphric pressure)

(calculated value)
Wg: Amount of water produced (m3) (calculated value)

(7) λ
Excess air factor

λ = (God × EXTo2 + 100 × Go2 − Ao × EXTo2) / ((20.948 − EXTo2) × Ao)

When concentration of oxygen remaining in exhaust gas is set to be measured and used
in calculations:

λ[N] = (God × EXTo2_ave[N] + 100 × Go2 − Ao × EXTo2_ave[N]) / ((20.948
− EXTo2_ave[N]) × Ao)

λ_ave = ave(λ[Ν]) # ave: average value
(the average value is displayed as a numerical analysis item and saved to a .csv file)

God: Theoretical volume of dry exhaust gas (m3) (at 0° C, 1 atomsphric
pressure) (calculated value)

EXTo2: Concentration of oxygen remaining in exhaust gas (%) (manually input)
Uses EXTo2_ave[N] (average concentration of oxygen remaining in
exhaust at each cycle) when concentration of oxygen remaining in
exhaust gas is set to be measured and used in calculations.
EXTo2_ave[N] = ave(EXTo2[720,N]) # ave: average value

Go2: Oxygen requirement (m3) (at 0° C, 1 atomsphric pressure) (calculated
value)

Ao: Theoretical air (m3) (at 0° C, 1 atomsphric pressure) (calculated value)
20.948: Oxygen concentration (%) in the air (manually input)

(8) Ac
Intake air volume (m3/h) relative to the fuel consumption

Ac = λ × Ao × Fc

When concentration of oxygen remaining in exhaust gas and fuel consumption are set to
be measured and used in calculations:
Ac[N] = λ[N] × Ao × Fc_ave[N]

Ac_ave = ave(Ac[N]) # ave: average value
(the average value is displayed as a numerical analysis item and saved to a .csv file)

λ: Excess air factor (calculated value)

Uses λ[N] (Excess air factor at each cycle, calculated value) when
concentration of oxygen remaining in exhaust gas and fuel consumption
are set to be measured and used in calculations.

Ao: Theoretical air (m3) (at 0° C, 1 atomsphric pressure) (calculated value)
Fc: Fuel consumption (m3/h) (manually input)

Uses average fuel consumption at each cycle when fuel consumption is

set to be measured and used in calculations.
Fc_ave[N] = ave(Fc[720,N]) # ave: average value

5.1  Explanation of Equations
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(9) Gin
Intake fuel-air mixture volume (m3/h)

Gin = (Fc + Ac ) × ((273.16 + Td) / 273.16) × (101.325 / Pa)

When concentration of oxygen remaining in exhaust gas, fuel consumption, intake

manifold temperature, and intake manifold pressure are set to be measured and used in
calculations:
Gin[N] = (Fc_ave[N] + Ac[N]) × ((273.16 + Td_ave[N]) / 273.16) × (101.325 / Pitk_ave[N])

Gin_ave = ave(Gin[N]) # ave: average value
(the average value is displayed as a numerical analysis item and saved to a .csv file)

Fc: Fuel consumption (m3/h) (manually input)
Uses Fc_ave[N] (average fuel consumption at each cycle, calculated
value) when fuel consumption is set to be measured and used in

calculations.
Fc_ave[N] = ave(Fc[720,N]) # ave: average value

Ac: Intake air volume (m3/h) (calculated)

Uses Ac[N] (average intake air volume at each cycle, calculated value)
when concentration of oxygen remaining in exhaust gas and fuel
consumption are set to be measured and used in calculations.

273.16: Correction value for absolute temperature
Td: Atmospheric temperature (°C) (manually input)

Uses Td_ave[N] (average intake manifold temperature at each cycle,

calculated value) when intake manifold temperature is set to be
measured and used in calculations.
Td_ave[N] = ave(Td[720,N]) # ave: average value

101.325: 1 atmosphere in kilopascals (kPa)
Pa: Atmospheric pressure (kPa) (manually input)

Uses Pitk_ave[N] (average intake manifold pressure at each cycle,

calculated value) when intake manifold pressure is set to be measured
and used in calculations.

5.1  Explanation of Equations
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(10)  ηv
Volumetric efficiency (%)

ηv = (Gin / ((1 / En_cyl) × Ne × Sn × Vst × 60)) × 100

When concentration of oxygen remaining in exhaust gas, fuel consumption, intake

manifold tempersture, and intake manifold pressure are set to be measured and used in
calculations:
ηv[N] = (Gin[N] / ((1 / En_cyl) × Ne_ave[N] × Sn × Vst × 60)) × 100

ηv_ave = ave(ηv[N]) # ave: average value
(the average value is displayed as a numerical analysis item and saved to a .csv file)

En_cyl: Engine cycle

4-cycle engine: En_cyl = 2
2-cycle engine: En_cyl = 1

Gin: Intake fuel-air mixture volume (m3/h) (calculated value)

Uses Gin[N] (intake fuel-air mixture volume at each cycle,
calculated value) when concentration of oxygen remaining in
exhaust gas, fuel consumption, intake manifold temperature, and intake

manifold pressure are set to be measured and used in calculations.
Ne: Revolutions per minute (rpm) (manually input)

Uses Ne_ave[N] (average rpm at each cycle) when rpm is set to be

measured and used in calculations.
Ne_ave[N] = ave(Ne[720,N]) # ave: average value

Sn: Number of cylinders (manually input)

Vst: Piston displacement (m3)

(11) Cv
Specific gravity of fuel gas

Cv = 0.554 × rCH4 + 1.0446 × rC2H6 + 1.5477 × rC3H8 + 2.0601 × rlC4H10 + 2.0722

× rNC4H10

rCH4: Composition ratio of methane (%) (manually input)
rC2H6: Composition ratio of ethane (%) (manually input)

rC3H8: Composition ratio of propane (%) (manually input)
rlC4H10: Composition ratio of isobutane (%) (manually input)
rNC4H10: Composition ratio of normal butane (%) (manually input)

rC4H10 = rlC4H10 + rNC4H10
0.554: Specific gravity of methane relative to the air
1.0446: Specific gravity of ethane relative to the air

1.5477: Specific gravity of propane relative to the air
2.0601: Specific gravity of isobutane relative to the air
2.0722: Specific gravity of normal butane relative to the air

5.1  Explanation of Equations
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(12) Ga, Gf
Ga: Mass of intake air (kg)

Gf: Mass of intake fuel (kg)

Ga = (Ac / ((1 / En_cyl) × Ne × Sn × 60)) × 1.2928
Gf = (Fc / ((1 / En_cyl) × Ne × Sn × 60)) × Cv × 1.2928

When concentration of oxygen remaining in exhaust gas, fuel consumption, and rpm are
set to be measured and used in calculations:

Ga[N] = (Ac[N] / ((1 / En_cyl) × Ne_ave[N] × Sn × 60)) × 1.2928
Gf[N] = (Fc_ave[N] / ((1 / En_cyl) × Ne_ave[N] × Sn × 60)) × Cv × 1.2928

Ac: Intake air volume (m3/h) (calculated)

Uses Ac[N] (average intake air volume at each cycle, calculated value)
when concentration of oxygen remaining in exhaust gas and fuel
consumption are set to be measured and used in calculations.

Fc: Fuel consumption (m3/h) (manually input)
Uses Fc_ave[N] (average fuel consumption at each cycle, calculated

value) when fuel consumption is set to be measured and used in
calculations.
Fc_ave[N] = ave(Fc[720,N]) # ave: average value

En_cyl: Engine cycle
4-cycle engine: En_cyl = 2
2-cycle engine: En_cyl = 1

Ne: Revolutions per minute (rpm) (manually input)
Uses Ne_ave[N] (average rpm at each cycle) when rpm is set to be
measured and used in calculations.

Ne_ave[N] = ave(Ne[720,N]) # ave: average value
Sn: Number of cylinders (manually input)
60: Factor for conversion from minutes to hours

Cv: Specific gravity of fuel gas (calculated value)
1.2928: Density of air (kg/m3) (0°C, 1 atmosphere)

(13) G
Mass of intake gas mixture (kg)

G = Ga + Gf

When concentration of oxygen remaining in exhaust gas and fuel consumption are set to
be measured and used in calculations:

G[N] = Ga[N] + Gf[N]

Ga: Mass of intake air (kg) (calculated value)

Uses Ga[N] (mass of intake air at each cycle, calculated value) when
concentration of oxygen remaining in exhaust gas and fuel consumption
are set to be measured and used in calculations.

Gf: Mass of intake fuel (kg) (calculated value)
Uses Gf[N] (mass of intake fuel at each cycle, calculated value) when
concentration of oxygen remaining in exhaust gas and fuel consumption

are set to be measured and used in calculations.

5.1  Explanation of Equations
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(14) R
Gas mixture constant (Jkg.K)

RCH4 = (1 × RCO2 + 2 × RH2O + 2 × (λ − 1) × RO2 + 2 × Nr × λ × RN2) / (1 + 2 + 2 × (λ
− 1) + 2 × Nr × λ)

RCH6 = (2 × RCO2 + 3 × RH2O + 3.5 × (λ − 1) × RO2 + 3.5 × Nr × λ × RN2) / (2 + 3

+ 3.5 × (λ − 1) + 3.5 × Nr × λ)
RC3H8 = (3 × RCO2 + 4 × RH2O + 5 × (λ − 1) × RO2 + 5 × Nr × λ× RN2) / (3 + 4 + 5 × (λ

− 1) + 5 × Nr × λ)

RC4H10 = (4 × RCO2 + 5 × RH2O + 6.5 × (λ − 1) × RO2 + 6.5 × Nr × λ × RN2) / (4 + 5
+ 6.5 × (λ − 1) + 6.5 × Nr × λ)

R = 1 / ((rCH4 / RCH4) + (rC2H6 / RCH6) + (rC3H8 / RC3H8) + (rC4H10 / RC4H10))

When concentration of oxygen remaining in exhaust gas is set to be measured and used
in calculations:

RCH4[N] = (1 × RCO2 + 2 × RH2O + 2 × (λ[N] − 1) × RO2 + 2 × Nr × λ[N] × RN2) / (1 + 2
+ 2 × (λ[N] − 1) + 2 × Nr × λ[N])

RC2H6[N] = (2 × RCO2 + 3 × RH2O + 3.5 × (λ[N] − 1) × RO2 + 3.5 × Nr × λ[N] × RN2)

/ (2 + 3 + 3.5 × (λ[N] − 1) + 3.5 × Nr × λ[N])
RC3H8[N] = (3 × RCO2 + 4 × RH2O + 5 × (λ[N] − 1) × RO2 + 5 × Nr × λ[N]× RN2) / (3

+ 4 + 5 × (λ[N] − 1) + 5 × Nr × λ[N])

RC4H10[N] = (4 × RCO2 + 5 × RH2O + 6.5 × (λ[N] − 1) × RO2 + 6.5 × Nr × λ[N] × RN2)
/ (4 + 5 + 6.5 × (λ[N] − 1) + 6.5 × Nr × λ[N])

R[N] = 1 / ((rCH4 / RCH4[N]) + (rC2H6 / RC2H6[N]) + (rC3H8 / RC3H8[N]) + (rC4H10

/ RC4H10[N]))

RCO2: 8314.3 / 43.9893 (J/kg.K)

RH2O: 8314.3 / 18.010565 (J/kg.K)
RO2: 8314.3 / 31.98983 (J/kg.K)
RN2: 8314.3 / 28.006148 (J/kg.K)

Nr: Ratio of nitrogen and oxygen in the air = 79.052 / 20.948
λ: Excess air factor (calculated value)

Uses λ[N] (Excess air factor at each cycle, calculated value) when

concentration of oxygen remaining in exhaust gas and fuel consumption
are set to be measured and used in calculations.

rCH4: Composition ratio of methane (%) (manually input)

rC2H6: Composition ratio of ethane (%) (manually input)
rC3H8: Composition ratio of propane (%) (manually input)
rC4H10: Composition ratio of butane (%) (manually input)

(= composition ratio of isobutane + composition ratio of n-butane)

5.1  Explanation of Equations
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(15)  Tθ[720, N]
Cylinder gas temperature (°C)

Tθ[720,N] = (Pθ[720,N] × 1000 × Vθ[720]) / (G × R) − 273.16

When concentration of oxygen remaining in exhaust gas and fuel consumption are set to

be measured and used in calculations:
Tθ[720,N] = (Pθ[720,N] × 1000 × Vθ[720]) / (G[N] × R[N]) − 273.16

Pθ: Cylinder pressure (kPa) after absolute pressure correction (calculated

value)
Vθ: Piston displacement (m3) (calculated value)
G: Mass of intake gas mixture (kg)  (calculated value)

Uses G[N] (mass of intake gas mixture at each cycle, calculated value)
when concentration of oxygen remaining in exhaust gas, fuel
consumption, and rpm are set to be measured and used in calculations.

R: Gas mixture constant (J/kg.K) (calculated value)
Uses R[N] (gas mixture constant at each cycle, calculated value) when
concentration of oxygen remaining in exhaust gas and fuel consumption

are set to be measured and used in calculations.

59. Tθ ave[720]
Average cylinder gas temperature (°C)

Tθ ave[720] = (1 / N) × Σ(Tθ [720,N])

N : Number of cycles
Tθ : Cylinder gas temperature (°C) (calculated value)

60. Tmax[N]
Maximum cylinder gas temperature (°C)

Tmax[N] = max(Tθ [720,N]) # max: maximum value

N : Number of cycles
Tθ : Cylinder gas temperature (°C) (calculated value)

61. θTmax[N]
Crank angle (CA) at maximum cylinder gas temperature

θTmax[N] = pos(Tθ [720,N]) # pos: crank angle at the maximum cylinder gas temperature

N : Number of cycles

Tθ : Cylinder gas temperature (°C) (calculated value)

62. Tmax_ave
Averaged maximum cylinder gas temperature (°C)

Tmax_ave = (1 / N) × Σ(Tmax [N])

N : Number of cycles
Tmax : Maximum cylinder gas temperature (°C) (calculated value)

5.1  Explanation of Equations
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63. Tmax_std
Standard deviation of maximum cylinder gas temperature (°C)

Tmax_std = sqrt((1 / (N–1)) × Σ(Tmax [N] – Tmax_ave)2) # sqrt: square root

N : Number of cycles

Tmax : Maximum cylinder gas temperature (°C) (calculated value)
Tmax_ave : Averaged maximum cylinder gas temperature (°C) (calculated value)

64. Tmax_cov
Rate of change in maximum cylinder gas temperature (%)

Tmax_cov = (Tmax_std / Tmax_ave) × 100

Tmax_std : Standard deviation of maximum cylinder gas temperature (°C)
(calculated value)

Tmax_ave : Averaged maximum cylinder gas temperature (°C) (calculated value)

65. dQθ[720,N]
Rate of heat release (J/deg)

(1) κθ[720,N]
Ratio of specific heat

T = Tθ[360,N] + 273.16
κθ[720,N] = 1.4373 − 1.318 × 10−4 × T + 3.12 × 10−8 × T2 − 4.8 × 10−2 / λ

When concentration of oxygen remaining in exhaust gas and fuel consumption are set to
be measured and used in calculations:
T = Tθ[360,N] + 273.16
κθ[720,N] = 1.4373 − 1.318 × 10−4 × T + 3.12 × 10−8 × T2 − 4.8 × 10−2 / λ[N]

Tθ : Cylinder gas temperature (°C) (calculated value)
λ: Excess air factor (calculated value)

Uses λ[N] (Excess air factor at each cycle, calculated value) when
concentration of oxygen remaining in exhaust gas and fuel consumption
are set to be measured and used in calculations.

(2) κθ ave[720]
Average ratio of specific heat

κθ ave[720] = (1 / N) × Σ(κθ [720,N])

N : Number of cycles
κθ : Ratio of specific heat (calculated value)

(3) dQ θ [720, N]
Rate of heat release (J/deg)

dQθ [720,N] = (κθ[720,N] / (κθ[720,N] − 1)) × Pθ [720,N] × 1000.0 × dVθ [720]
+ (1 / (κθ[720,N] − 1)) × dPθ[720,N] × 1000.0 × Vθ [720]

N : Number of cycles

κθ : Ratio of specific heat (calculated value)
Pθ : Cylinder pressure (kPa) after absolute pressure correction (calculated

value)

Vθ : Piston displacement (m3) (calculated value)
dPθ : Rate of cylinder pressure rise (kPa/deg) (calculated value)

5.1  Explanation of Equations
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66. dQθ ave [720]
Average rate of heat release (J/deg)

dQθ ave[720] = (1 / N) × Σ(dQθ [720,N])

N : Number of cycles

dQθ : Rate of heat release (J/deg) (calculated value)

67. dQmax[N]
Maximum rate of heat release (J/deg)

dQmax[N] = max(dQθ [720,N])
# max: Indicates the maximum value within the manually input search range of the
maximum rate of release.

N : Number of cycles

dQθ : Rate of heat release (J/deg) (calculated value)

68. θdQmax[N]
Crank angle at maximum rate of heat release (CA)

θdQmax[N] = pos(dQθ [720,N]) # pos: crank angle at maximum rate of heat release

N : Number of cycles
dQθ : Rate of heat release (J/deg) (calculated value)

69. θdQmax_ave
Averaged crank angle at maximum rate of heat release (CA)

θdQmax_ave = (1 / N) × Σ(θdQmax [N])

N : Number of cycles
θdQmax : Crank angle at maximum rate of heat release (CA) (calculated value)

70. dQmax_ave
Averaged maximum rate of heat release (J/deg)

dQmax_ave = (1 / N) × Σ(dQmax [N])

N: Number of cycles

dQmax : Maximum rate of heat release (J/deg) (calculated value)

71. dQmax_std
Standard deviation of maximum rate of heat release (J/deg)

dQmax_std = sqrt((1 / (N–1)) × Σ(dQmax [N] – dQmax_ave)2) # sqrt: square root

N: Number of cycles
dQmax : Maximum rate of heat release (J/deg) (calculated value)
dQmax_ave : Averaged maximum rate of heat release (J/deg) (calculated value)

72. dQmax_cov
Rate of change (%) in maximum rate of heat release

dQmax_cov = (dQmax_std / dQmax_ave) × 100

dQmax_std : Standard deviation of the maximum rate of heat release (J/deg)

(calculated value)
dQmax_ave : Averaged maximum rate of heat release (J/deg) (calculated value)

5.1  Explanation of Equations
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73. Qθ [720,N]
Amount of heat release (J)

Qθ [720,N] = Σ (dQθ ) × res
Cumulative sum from point a to θ.  dQθ is zero from 0 to point a.

N : Number of cycles
dQθ : Rate of heat release (J/deg) (calculated value)
res : Angular resolution (1, 0.5, 0.25, or 0.1 CA)

a : Start point of combustion.  Crank angle (CA) at which the value of dQθ

is changed to a positive value immediately before Qmax (calculated
value) (value automatically searched for, starting from dQmax in the

direction of decreasing angles)
When manually input, the setting value is assumed to be point “a.”

74. Qθ ave [720]
Average amount of heat release (J)

Qθ ave[720] = (1 / N) × Σ(Qθ [720,N])

N : Number of cycles
Qθ : Amount of heat release (J) (calculated value)

75. Qmax [N]
Maximum amount of heat release (J)

Qmax[N] = max(Qθ [720,N]) # max: maximum value

N : Number of cycles

Qθ : Amount of heat release (J) (calculated value)

76. θQmax [N]
Crank angle (CA) at maximum amount of heat release

θQmax[N] = pos(Qθ [720,N]) # pos: crank angle at the maximum amount of heat release

N : Number of cycles
Qθ : Amount of heat release (J) (calculated value)

77. θQmax_ave
Averaged crank angle at maximum amount of heat release (CA)

θQmax_ave = (1 / N) × Σ(θQmax [N])

N : Number of cycles
θQmax : Crank angle at maximum amount of heat release (CA) (calculated

value)

78. Qmax_ave
Averaged maximum amount of heat release (J)

Qmax_ave = (1 / N) × Σ(Qmax [N])

N : Number of cycles
Qmax : Maximum amount of heat release (J) (calculated value)

5.1  Explanation of Equations
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79. Qmax_std
Standard deviation of maximum amount of heat release (J)

Qmax_std = sqrt((1 / (N–1)) × Σ(Qmax [N] – Qmax_ave)2) # sqrt: square root

N : Number of cycles

Qmax : Maximum amount of heat release (J) (calculated value)
Qmax_ave : Averaged maximum amount of heat release (J) (calculated value)

80. Qmax_cov
Rate of change (%) in maximum amount of heat release

Qmax_cov = (Qmax_std / Qmax_ave) × 100

Qmax_std : Standard deviation of maximum amount of heat release (J) (calculated
value)

Qmax_ave : Averaged maximum amount of heat release (J) (calculated value)

81. Qab
Amount of heat release during the combustion period (J)

Qab[N] = Σ (dQθ [720,N]) × res
The sum from point a to point b at each cycle

N : Number of cycles
dQθ : Rate of heat release (J/deg) (calculated value)

res : Angular resolution (1, 0.5, 0.25, or 0.1 CA)
a : Start point of combustion.  Crank angle (CA) at which the value of dQθ

is changed to a positive value immediately before dQmax (calculated

value)
When manually input, the setting value is assumed to be point “a.”

b : End point of combustion.  Crank angle (CA) at which the value of dQθ is

changed to a negative value immediately after dQmax (calculated
value)
When manually input, the setting value is assumed to be point “b.”

82. Qab_ave
Average amount of heat release during the combustion period (J)

Qab_ave = (1 / N) × Qab [N]

N : Number of cycles

Qab : Amount of heat release during the combustion period (J) (calculated
value)

83. RHθ [720,N]
Combustion mass rate (%)

RHθ [720, N] = Qθ [720,N] / Qab[N]

N : Number of cycles
Qθ : Amount of heat release (J) (calculated value)

Qab : The calculated sum (J) from point a to point b at each cycle

5.1  Explanation of Equations
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84. RHθ ave [720]
Average combustion mass rate (%)

RHθ ave[720] = (1 / N) × Σ(RHθ [720,N])

N : Number of cycles
RHθ : Combustion mass rate (%) (calculated value)

85. θRH[N]
Crank angle at combustion mass rate N1 % (CA)

(the crank angle such that the combustion mass rate is N1 %)

θRH[N] = floor(round(RHθ[720,N]), ratio)
# floor: the angle whereby RHθ is greater than ratio (depending on the angular
resolution)
# round: round to 1 digit after the decimal place

N : Number of cycles
RHθ : Combustion mass rate (%) (calculated value)
ratio : Ratio for judging angle of combustion mass rate N1 % (%) (manually

input)

86. θRH_ave
Averaged angle at combustion mass rate N1 % (CA)

θRH_ave = (1 / N) × Σ(θRH [N])

N : Number of cycles
θRH : Angle at combustion mass rate N1 % (CA) (calculated value)

87. θRH_std
Standard deviation of angle at combustion mass rate N1 % (CA)

θRH_std = sqrt((1 / (N – 1)) × Σ(θRH [N] – θRH_ave)2) # sqrt: square root

N: Number of cycles
θRH : Angle at combustion mass rate N1 % (CA) (calculated value)
θRH_ave : Averaged angle at combustion mass rate N1 % (CA) (calculated value)

88. θRH_cov
Rate of change in angle at combustion mass rate N1 % (CA)

θRH_cov = (θRH_std / θRH_ave) × 100

θRH_std : Standard deviation of angle at combustion mass rate N1 % (CA)
(calculated value)

θRH_ave : Averaged angle at combustion mass rate N1 % (CA) (calculated value)

5.1  Explanation of Equations
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89. θRH2[N]
Crank angle at combustion mass rate N2 % (CA)

(the crank angle such that the combustion mass rate is N2 %)

θRH2[N] = floor(round(RHθ[720,N]), ratio2)
# floor: the angle whereby RHθ is greater than ratio2 (depending on the angular
resolution)
# round: round to 1 digit after the decimal place

N : Number of cycles
RHθ : Combustion mass rate (%) (calculated value)
ratio2 : Ratio for judging angle of combustion mass rate N2 % (%) (manually

input)

90. θRH2_ave
Averaged angle at combustion mass rate N2 % (CA)

θRH2_ave = (1 / N) × Σ(θRH2 [N])

N : Number of cycles
θRH2 : Angle at combustion mass rate N2 % (CA) (calculated value)

91. θRH2_std
Standard deviation of angle at combustion mass rate N2 % (CA)

θRH2_std = sqrt((1 / (N – 1)) × Σ(θRH2 [N] – θRH2_ave)2) # sqrt: square root

N: Number of cycles
θRH2 : Angle at combustion mass rate N2 % (CA) (calculated value)

θRH2_ave : Averaged angle at combustion mass rate N2 % (CA) (calculated value)

92. θRH2_cov
Rate of change in angle at combustion mass rate N2 % (CA)

θRH2_cov = (θRH2_std / θRH2_ave) × 100

θRH2_std : Standard deviation of angle at combustion mass rate N2 % (CA)
(calculated value)

θRH2_ave : Averaged angle at combustion mass rate N2 % (CA) (calculated value)

93. θRH3[N]
Crank angle at combustion mass rate N3 % (CA)

(the crank angle such that the combustion mass rate is N3 %)

θRH3[N] = floor(round(RHθ[720,N]), ratio3)
# floor: the angle whereby RHθ is greater than ratio3 (depending on the angular
resolution)
# round: round to 1 digit after the decimal place

N : Number of cycles
RHθ : Combustion mass rate (%) (calculated value)
ratio3 : Ratio for judging angle of combustion mass rate N3 % (%) (manually

input)

5.1  Explanation of Equations
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94. θRH3_ave
Averaged angle at combustion mass rate N3 % (CA)

θRH3_ave = (1 / N) × Σ(θRH3 [N])

N : Number of cycles

θRH3 : Angle at combustion mass rate N3 % (CA) (calculated value)

95. θRH3_std
Standard deviation of angle at combustion mass rate N3 % (CA)

θRH3_std = sqrt((1 / (N – 1)) × Σ(θRH3 [N] – θRH3_ave)2) # sqrt: square root

N: Number of cycles
θRH3 : Angle at combustion mass rate N3 % (CA) (calculated value)
θRH3_ave : Averaged angle at combustion mass rate N3 % (CA) (calculated value)

96. θRH3_cov
Rate of change in angle at combustion mass rate N3 % (CA)

θRH3_cov = (θRH3_std / θRH3_ave) × 100

θRH3_std : Standard deviation of angle at combustion mass rate N3 % (CA)

(calculated value)
θRH3_ave : Averaged angle at combustion mass rate N3 % (CA) (calculated value)

97. Qi
True heat release of gas fuel (J/m3) at 0° C, 1 atomsphric pressure
This calculation is not performed if manually input settings were specified for use in the
parameter setting screen.

Qi = 4.18605 × 1000 × (8670 × rCH4 + 15380 × rC2H6 + 22350 × rC3H8 + 29610
× rC4H10)

rCH4: Composition ratio of methane (%) (manually input)
rC2H6: Composition ratio of ethane (%) (manually input)
rC3H8: Composition ratio of propane (%) (manually input)
rC4H10: Composition ratio of butane (%) (manually input)

(= composition ratio of isobutane + composition ratio of n-butane)

4.18605: 4.18605(J) = 1(cal)

5.1  Explanation of Equations
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5.1  Explanation of Equations

98. Qc
Cooling loss (J)

Qc = ((Qi × Fc) / ((1 / En_cyl) × 60 × Ne × Sn)) − Qab_ave

When fuel consumption and rpm are set to be measured and used in calculations:

Qc[N] = ((Qi × Fc_ave[N]) / ((1 / En_cyl) × 60 × Ne_ave[N] × Sn)) − Qab_ave
Qc_ave = ave(Qc [N]) # ave: average value
(the average value is displayed as a numerical analysis item and saved to a .csv file)

Qi: True heat release of gas fuel (J/m3)
Qab_ave: Average amount of heat release (J) (calculated value)
Fc: Fuel consumption (m3/h) (manually input)

Uses average fuel consumption at each cycle when fuel consumption is
set to be measured and used in calculations.
Fc_ave[N] = ave(Fc[720,N]) # ave: average value

Ne: Revolutions per minute (rpm) (manually input)
Uses Ne_ave[N] (average rpm at each cycle) when rpm is set to be
measured and used in calculations.

Ne_ave[N] = ave(Ne[720,N]) # ave: average value
Sn: Number of cylinders (manually input)
60: Factor for conversion from minutes to hours

En_cyl: Engine cycle
4-cycle engine: En_cyl = 2
2-cycle engine: En_cyl = 1

99. ηc
Cooling loss ratio (%)

ηc = (Qc / ((Qi × Fc) / ((1 / En_cyl) × 60 × Ne × Sn))) × 100

When fuel consumption and rpm are set to be measured and used in calculations:

ηc[N] = (Qc[N] / ((Qi × Fc_ave[N]) / ((1 / En_cyl) × 60 × Ne_ave[N] × Sn))) × 100
ηc_ave = ave(ηc [N]) # ave: average value
(the average value is displayed as a numerical analysis item and saved to a .csv file)

Qc: Cooling loss (J) (calculated value)
Uses Qc]N] (cooling loss at each cycle, calculated value) when fuel

consumption and rpm are set to be measured and used in calculations.
Qi: True heat release of gas fuel (J/m3)
Fc: Fuel consumption (m3/h) (manually input)

Uses average fuel consumption at each cycle when fuel consumption is
set to be measured and used in calculations.
Fc_ave[N] = ave(Fc[720,N]) # ave: average value

Ne: Revolutions per minute (rpm) (manually input)
Uses Ne_ave[N] (average rpm at each cycle) when rpm is set to be
measured and used in calculations.

Ne_ave[N] = ave(Ne[720,N]) # ave: average value
Sn: Number of cylinders (manually input)
60: Factor for conversion from minutes to hours

En_cyl: Engine cycle
4-cycle engine: En_cyl = 2
2-cycle engine: En_cyl = 1
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5.1  Explanation of Equations

100. ηe
Brake thermal efficiency (%)

ηe = ((PS × 3600 × 1000) / (Qi × Fc)) × 100

When fuel consumption is set to be measured and used in calculations:

ηe[N] = ((PS × 3600 × 1000) / (Qi × Fc_ave[N])) × 100
ηe_ave = ave(ηe [N]) # ave: average value
(the average value is displayed as a numerical analysis item and saved to a .csv file)

PS: Engine power (kW) (manually input)
Qi: True heat release of gas fuel (J/m3)
Fc: Fuel consumption (m3/h) (manually input)

Uses average fuel consumption at each cycle when fuel consumption is
set to be measured and used in calculations.
Fc_ave[N] = ave(Fc[720,N]) # ave: average value

101. ηf
Friction loss (%)

Pme = (9000 / (Ne × Vmax × Sn)) × PS × 1.35962 × 9.80665 × 0.001
Pmf = NMEP_ave / Pme

PSf = ((Ne × Vmax × Sn) / (9000 × 9.80665)) × Pmf × 1000
ηf = ((PSf × 632.4 × 100) / (Qi × Fc)) × 4.18605 × 1000

When fuel consumption and rpm are set to be measured and used in calculations:
Pme = (9000 / (Ne_ave[N] × Vmax × Sn)) × PS × 1.35962 × 9.80665 × 0.001
Pmf = NMEP_ave − Pme

PSf = ((Ne_ave[N] × Vmax × Sn) / (9000 × 9.80665)) × Pmf × 1000
ηf[N] = ((PSf × 632.4 × 100) / (Qi × Fc_ave[N])) × 4.18605 × 1000
ηf_ave = ave(ηf[N]) # ave: average value
(the average value is displayed as a numerical analysis item and saved to a .csv file)

Ne: Revolutions per minute (rpm) (manually input)
Uses Ne_ave[N] (average rpm at each cycle) when rpm is set to be

measured and used in calculations.
Ne_ave[N] = ave(Ne[720,N]) # ave: average value

Vmax: Maximum piston displacement (m3) (calculated value)

Sn: Number of cylinders (manually input)
PS: Engine power (kW) (manually input)
Pme: Brake mean effective pressure (kPa)

NMEP_ave: Averaged NMEP (kPa)
Pmf: Friction mean effective pressure (kPa)
PSf Friction loss ( × 0.7355(kW))

Qi: True heat release of gas fuel (J/m3)
Fc: Fuel consumption (m3/h) (manually input)

Uses average fuel consumption at each cycle when fuel consumption is

set to be measured and used in calculations.
Fc_ave[N] = ave(Fc[720,N]) # ave: average value
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5.1  Explanation of Equations

102. Qe
Combustion efficiency (%)

Qe = (Qab_ave × 100) / (Qi × (Fc / ((1 / En_cyl) × Ne × Sn × 60)))

When fuel consumption and rpm are set to be measured and used in calculations:

Qe[N] = (Qab_ave × 100) / (Qi × (Fc_ave[N] / ((1 / En_cyl) × Ne_ave[N] × Sn × 60)))
Qe_ave = ave(Qe [N]) # ave: average value
(the average value is displayed as a numerical analysis item and saved to a .csv file)

Qab_ave: Average amount of heat release (J) (calculated value)
Qi: True heat release of gas fuel (J/m3)
Fc: Fuel consumption (m3/h) (manually input)

Uses average fuel consumption at each cycle when fuel consumption is
set to be measured and used in calculations.
Fc_ave[N] = ave(Fc[720,N]) # ave: average value

Ne: Revolutions per minute (rpm) (manually input)
Uses Ne_ave[N] (average rpm at each cycle) when rpm is set to be
measured and used in calculations.
Ne_ave[N] = ave(Ne[720,N]) # ave: average value

Sn: Number of cylinders (manually input)
60: Factor for conversion from minutes to hours
En_cyl: Engine cycle

4-cycle engine: En_cyl = 2
2-cycle engine: En_cyl = 1

103. PolYθ [720]
Polytropic index

PolYθ [720] = – (log10(Pθ ave[n–1] / Pθ ave [n]) / log10 (Vθ [n–1] / Vθ [n]))
n = 0 to 719.  when n = 0, Polyθ = 1.

Pθ ave : Average cylinder pressure (kPa)
Vθ : Piston displacement (m3)

104. Vmax
Maximum piston displacement (m3)

When Clearance volume is selected on the Parameter Settings screen
Vmax = Vst + Vc
When Compression ratio is selected on the Parameter Settings screen

Vmax = Vst + (Vst / (Cr – 1))

Vst : Piston displacement (m3)
Vc : Clearance volume (m3)

Cr : Compression ratio (manually input)
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105. Dc
Degree of constant volume

Dc = (1 / Qmax_ave) × Σ(dQθ ave[720] × res × (1 / ((Vθ[720] / Vmax)(κθave[720] − 1)))
 / (1 – ((1 / Cr)(κθave[720] − 1))))
Σ is the sum from a_ave to b_ave.

Qmax_ave: Averaged maximum amount of heat release (J)
dQθave: Average rate of heat release (J/deg) (calculated value)
res: Angular resolution (manually input)
Vθ : Piston displacement (m3) (calculated value)
Vmax: Maximum piston displacement (m3) (calculated value)
κθave: Average ration of specific heat (calculated value)
Cr: Compression ratio (manually input)

Cr = Vmax / Vc: when the clearance volume is specified in the
parameter setting screen.

106. ηi
Indicated efficiency (%)

ηi = (NMEP_ave × 1000 × Vst / (Qi × (Fc / ((1 / En_cyl) × Ne × Sn × 60)))) × 100

When fuel consumption and rpm are set to be measured and used in calculations:
ηi[N] = (NMEP_ave × 1000 × Vst / (Qi × (Fc_ave[N] / ((1 / En_cyl) × Ne_ave[N] × Sn

 × 60)))) × 100
ηi_ave = ave(ηi [N]) # ave: average value
(the average value is displayed as a numerical analysis item and saved to a .csv file)

NMEP_ave: Average NMEP (kPa)
Vst: Piston displacement (m3) (calculated value)
Qi: True heat release of gas fuel (J/m3)
Fc: Fuel consumption (m3/h) (manually input)

Uses average fuel consumption at each cycle when fuel consumption is
set to be measured and used in calculations.
Fc_ave[N] = ave(Fc[720,N]) # ave: average value

Ne: Revolutions per minute (rpm) (manually input)
Uses Ne_ave[N] (average rpm at each cycle) when rpm is set to be
measured and used in calculations.
Ne_ave[N] = ave(Ne[720,N]) # ave: average value

Sn: Number of cylinders (manually input)
60: Factor for conversion from minutes to hours
En_cyl: Engine cycle

4-cycle engine: En_cyl = 2
2-cycle engine: En_cyl = 1

107. chXθ ave[720]
Other signals (crank angle graph data)

chXθ ave[720] = (1 / N) × Σ(chX[720,N])

N : Number of cycles
chX : Measured value of chX

5.1  Explanation of Equations
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108. chXave[N]
Other signals (cycle graph data)

chXave[N] = ave(chX[720,N]) # ave: average value

N : Number of cycles
chX : Measured value of chX

109. a_ave
Average start point of combustion (CA)

a_ave = (1 / N) × Σa[N]

N : Number of cycles
a : Crank angle (CA) at which the value of dQθ is changed to a positive

value immediately before dQmax (calculated value)
When manually input, the setting value is assumed to be point “a.”

110. b_ave
Average end point of combustion (CA)

b_ave = (1 / N) × Σb[N]

N : Number of cycles
b : Crank angle (CA) at which the value of dQθ is changed to a negative

value immediately after dQmax (calculated value)
When manually input, the setting value is assumed to be point “b.”

5.1  Explanation of Equations



6-1IM 707765-61E

M
o

n
ito

r F
u

n
ctio

n
s (A

d
d

-O
n

)

6

Chapter 6 Monitor Functions (Add-On)

6.1 Overview

This function is an add-on for the Engine Combustion Pressure Analysis Package.
This function is only available when used in conjunction with the Engine Combustion

Pressure Analysis Package.
With the Monitor Function, you can use your WE7000 series instrument (WE7235,
WE7245, WE7271, WE7272, or WE7275) or the DL750 to measure cylinder pressure

over given periods of time during motoring or firing, and continuously monitor the
measurements.  You can also save the resultant data.

• Monitoring Raw Data (Motoring Data)
• Displays one cycle's worth of raw (measured) data before or after TDC correction.
• If filters were applied, filtered waveforms are displayed.

• The specified number of cycles of raw (measured) data is acquired, then saved in
WVF format.

• Monitoring Analysis Results (Firing Data)
• TDC correction and absolute pressure correction are performed on the data, then

analysis results below are displayed according to monitor items that the user

selects.

Monitor Items Crank Angle Graph Monitor Numerical Value monitor

Cylinder pressure Maximum cylinder pressure and the corresponding crank angle
None P-V graph NMEP

Other Signals IMEP
PMEP

dP Rate of cylinder pressure rise Maximum rate of cylinder pressure rise and the corresponding
crank angle

T Cylinder gas temperature Maximum cylinder gas temperature and the corresponding crank
angle

dQ Rate of heat release Maximum rate of heat release and the corresponding crank angle

Q Amount of heat release Maximum amount of heat release and the corresponding crank
angle

Combustion mass rate Crank angle such that the combustion mass rate is N1 %
Crank angle such that the combustion mass rate is N2 %
Crank angle such that the combustion mass rate is N3 %
Start point of combustion (point a)
Etart point of combustion (point b)

• If filters were applied, the filtered waveforms are displayed.
• The specified number of cycles of data to undergo combustion pressure analysis is

acquired, then saved in WVF format.

• Entering Conditions
Enter the conditions below before executing the monitor function.

• Measurement conditions
• Parameter conditions
• Filter conditions
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Procedure
Use the monitor function according to the procedure in the figure below.

Configuring
 WE7000 or DL750

Entering 
manually input dataSetting filter

Monitoring raw data

Saving data

Start

Motoring

Selecting a file

Setting filter

Monitoring cylinder 
pressure after calculation

Saving data

TDC Correction

Firing

TDC Correction
Setting calibration factors

Setting channels 

Selecting a file

Combustion 
pressure analysis

Performing combustion 
pressure analysis

Saving analysis results

Monitor Functions
of

Engine Combustion 
Pressure

Engine Combustion 
Pressure Analysis

Setting 
Measurement Condition

Enter the following settings.
• Channel conditions (use channels 1 through 16)
• Trigger conditions (however, do not use a pretrigger)
• Time base conditions

(section 3.2)  

(section 6.6)  

(section 6.7)  

(section 6.14)  

(section 6.10)  

(sections 6.8 and 6.9)  

(section 6.6)  

(section 3.2)  

(sections 3.9, 3.10, 
 and 3,11)  

(section 3.3)  

(section 6.10)  

(section 6.13)  

(section 6.12, 
Appendix 1, 
Appendix 2)  

(section 3.13)  

6.1  Overview
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Processing
The monitor function operates as shown in the figure below.

Data acquisition

Filter processing

TDC correction

Crank angle graph display

<Motoring Mode>

Data acquisition

Filter processing

Rotational offset correction

Graph display

<Firing Mode>

TDC correction

Calculation

Numeric display

Absolute pressure 
correction

Rotational offset correction

Rotational offset correction and TDC 
correction are the same process as 
in the Combustion Pressure Analysis 
Package.

Rotational offset correction and TDC 
correction are the same process as 
in the Combustion Pressure Analysis 
Package.

6.1  Overview
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6.2 Setup

Installing the Software
Use the setup program on the CD to install the Monitor Function.

Run the file, CD Drive/Disk1/Setup.exe.
Use the same destination folder for the installation that you used for the Engine
Combustion Pressure Analysis.

If your operating system is Windows NT, 2000, or XP, log in as the administrator.

Hardware Configuration
Please see the appendix.



6-5IM 707765-61E

M
o

n
ito

r F
u

n
ctio

n
s (A

d
d

-O
n

)

6

6.3 Screens

Change to this function by choosing File > Start Monitor Functions (see section 3.6).
You can also change to this function when the menu bar of the Engine Combustion

Pressure Analysis is displayed by selecting (activating) a window related to the monitor
function.

Menu Bar of the Monitor for the Engine Combustion Pressure Analysis Package

Help menu

Help (display user's manual)

Window menu
Graph menu

Calculation menu
Settings menu

View menu
Edit menu

File menu

Monitor menu

Restore the minimized window

Save screen to BMP file
Minimize the window

Move cursor

Enter setup conditions
Enter measurement conditions

Start monitoring
Stop monitoring

Save data to WVF file

Start monitor function
Enter color settings

Enter cycle display settings
Enter axis range settings

Enter 3D graph settings
Execute calculation

Enter parameter settings
TDC and calibration factor settings

Enter filter settings
Save analysis conditions

Load analysis conditions
Save to CSV file

Load waveform data
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6.4 Common Operations

The following operations can be performed when monitoring is interrupted.

Right-Clicking the Mouse

If you right-click on a window displaying a graph, you can execute the following
commands from the pull-down menu.
• Measured Data: Opens a window displaying a crank angle graph of raw data and

corrected data.  You can enter these settings while monitoring is being performed.
• Crank angle graph: Opens a window displaying a crank angle graph of calculated

analysis items.  You can enter these settings while monitoring is being performed.

• Numeric analysis data items: Opens a window displaying numeric analysis results
from calculated analysis items.  You can enter these settings while monitoring is being
performed.

• Axis range: Displays the graph axes setting screen.  You can manually enter a fixed
value for the X and Y axes, or choose Autoscale.

• Display channels: Displays a pull-down menu for display channels.

• Graph colors: Displays the graph color setting screen.

Moving the Cursor
Values can be read in directly using the cursor.  If you click in a window displaying a

graph, the cursor (a vertical bar) jumps to the point where the mouse was clicked, and
the X and Y axes of that point are displayed.  Cursors (displayed as vertical bars) can be
moved from left to right.

: Fast left cursor

: Left cursor

: Right cursor

: Fast right cursor

Displaying the Mouse Pointer Position
When the mouse is moved over a graph, the X and Y value of the current position is

displayed on the graph.

Save Screen to BMP File
When monitoring is interrupted, press the  button to save a bit map image of the

active graph window.

Displaying Help Information
When monitoring is interrupted, you can display the user's manual in PDF format.
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6.5 File > Load Measured Data

Functions
• This is the same function as the one described in section 3.2, “File > Load Measured

Data.”
• You can select and load previously saved waveform data files.  You can analyze

previously saved analysis data while monitoring.
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6.6 File > Save Monitoring Results

Functions
• Automatically pauses monitoring, acquires the specified number of cycles according

to the measurement conditions, and displays the File Save dialog box.  The saved
files contain raw (measured) data that has not undergone TDC correction or filtering.
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6.7 View > Measured Data

Functions
• Filters are applied to raw (measured) data according to the filter conditions, which is

then displayed in the crank angle graph.
• The following shows the contents of the display for each command.

View > Measured data > Raw data: Raw (measured) data before TDC correction

View > Measured data > Corrected data: Raw (measured) data after TDC correction
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6.8 View > Crank Angle Graph

Functions
• Displays a crank angle graph of the combustion pressure analysis results being

monitored.
• The selected values from the numeric analysis data items and the measurement items

set to Use in Calculations in the Parameter Setting screen are displayed in the lower

left portion of the screen.
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6.9 View > Numeric Analysis Data Items

Functions
• Displays numeric analysis data items of the combustion pressure analysis results.
• One of the numeric analysis data items is displayed as a trend.
• The selected values from the cycle graph data items and the measurement items set

to Use in Calculations in the Parameter Setting screen are displayed in the lower right
portion of the screen.
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6.10 Settings > Filter

Functions
• This is the same function as described in section 3.12, “Settings > Filter.”  You can

enter these settings when monitoring is paused.
• The settings take effect when monitoring is resumed.
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6.11 Settings > TDC Correction and Calibration
Factor Settings

Functions
• This is the same function as the one described in section 3.13, “Settings > TDC

Correction and Calibration Factor Settings.”  There is no execution function for
calculation of the TDC correction value.  It is manually input.

• The settings take effect when monitoring is resumed.
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6.12 Settings > Setup

Functions
• This is the same function as described in section 3.6, “File > Start Monitor Functions.”
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6.13 Settings > Measurement Conditions

Functions
• With monitoring stopped, you can enter the angular resolution and number of cycles

to be acquired and saved.
• Select the monitor items.  The settings take effect when monitoring is resumed.

Monitor Items Crank Angle Graph Monitor Numerical Value monitor

Cylinder pressure Maximum cylinder pressure and the corresponding crank angle
None P-V graph NMEP

Other Signals IMEP
PMEP

dP Rate of cylinder pressure rise Maximum rate of cylinder pressure rise and the corresponding
crank angle

T Cylinder gas temperature Maximum cylinder gas temperature and the corresponding crank
angle

dQ Rate of heat release Maximum rate of heat release and the corresponding crank angle

Q Amount of heat release Maximum amount of heat release and the corresponding crank
angle

Combustion mass rate Crank angle such that the combustion mass rate is N1 %
Crank angle such that the combustion mass rate is N2 %
Crank angle such that the combustion mass rate is N3 %
Start point of combustion (point a)
Etart point of combustion (point b)

Setting/Display Data

No. Item Initial Value Data Size Numeric Data Input (I) /
Type Min. Value Max. Value Select (S)

1 Angular Resolution Prev. value - - - - S

2 No. of Cycles to Prev. value I 3.0 1 800 I
Acquire/Save

3 Select Items to Monitor Prev. value - - - - S

(1) Angular Resolution: You can select 0.1, 0.25, 0.5, or 1.
(2) No. of Cycles to Acquire/Save: Input the number of cycles to acquire.

Button Operations
OK Button

Activates all on-screen settings, and closes the window.
Cancel Button

Clears all on-screen settings, and closes the window.
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6.14 Calculation > Set Parameters

Functions
• This is the same function as the one described in section 3.14, “Calculation > Set

Parameters.”
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6.15 Monitor

Functions
• Starts and stops monitoring.
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6.16 Graph

Functions
• These are the same functions as the ones described in section 6.4, “Common

Operations.”
They include axis settings, displayed channels, and graph color settings.
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Chapter 7 Error Messages

7.1 A List of Error Messages

The messages in the table below appear in response to errors that may occur.

Messages Description

Failed to acquire ASCII header information. .hdr file not found.

Failed to create analysis work data. .wvf file does not exist, or WVF file format incorrect.

Setup information is not correct or power to the instrument is not ON. -

The range defined by the start cycle and end cycle settings exceeds -
the number of effective cycles.
Please reenter the values.

Start cycle cannot be greater than the end cycle. -

Application has already started. (Two simultaneous sessions prohibited.) -

The default drive may have insufficient free space.  Analysis results -
may not be able to be saved.  OK to continue?

Analysis results not saved.   Save the results? -

The measuring instrument of the selected waveform data does not match!! -
If you continue, the data may not be displayed or calculated correctly.
Do you still wish to continue?

X axis range not entered correctly. -

Y axis range not entered correctly. -

Illegal setting value. The input value exceeded the upper or lower limit
for the setting.

Failed to load the analysis conditions. The format of the analysis file (.ecp) is incorrect.

Cannot exit during monitoring. -
Please stop monitoring before exiting.
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Appendix

Appendix 1 Setting Up the WE7000

First, enter all necessary settings on the WE7000 control software.
The following is an example of how the WE7000 would be configured to measure the

pressure in one cylinder assuming one WE7272 module is installed, and a PC is
connected.

Sigmal Connection

TRIGIN: Angular pulse
 (TTL level signal)

CH2: TDC pulse
CH1: Cylinder pressure
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<Module Settings>
(1) On

Connect cylinder pressure signals in the firing order starting from channel 1.
Connect the TDC pulse signal to a channel not being used for cylinder pressure
measurement.

In this example, CH1 is assigned to cylinder pressure, and CH2 is assigned to
TDC pulse.

(2) Range
Set the measurement range appropriate for the input voltage.

(3) Trig Type
Uses the TDC pulse signal as the trigger.

Set CH2 to Rise or Fall.
Turn CH1 (cylinder pressure measurement) off.

(4) Trig Level (V)
Set the trigger level on the channel connected to TDC pulse (CH2).

(5) Filter
Set when the low pass filter is applied as analog processing.

(6) Acquisition Mode
Select Triggered.

(7) Memory Partition
Set to 1.
This is automatically set with the Monitor Function add-on for the Engine
Combustion Pressure Analysis.

(8) Record Length
Enter settings as follows:

Record length ≥ (no. of analyzed cycles + 3) × 1 cycle data length

For 4-cycle engine: 1 cycle data length = (360/res) × 2
For 2-cycle engines: 1 cycle data length = (360/res)
res = angular resolution (1, 0.5, 0.25, 0.1)

For example, with a 4-cycle engine at an angular resolution of 0.5 CA, and 100
cycle’s worth of data acquired:
From the equation:  Record length = (100+3) × 1440 = 148320,  enter 148320.

This is automatically set with the Monitor Function add-on for the Engine
Combustion Pressure Analysis.

(9) No. of Acquisitions
Set to 1.
This is automatically set with the Monitor Function add-on for the Engine
Combustion Pressure Analysis.

 

(2) (3) (4) (5)

(7)

(8)

(9)

(1)

(6)

Appendix 1  Setting Up the WE7000
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(10) Trigger/Source
Select Internal.

(11) Misc/Time Base
Select BUSCLK.

(12) CH Mode
Select the number of measurement channels depending on the number of input
channels.

(13) Overlapped Acquisition
Unselected

(14) Pretrigger
Set to 0.

(11)
(12)

(13)

(10)

(14)

Appendix 1  Setting Up the WE7000
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<Trigger Information Settings>
Enter the following settings for the TDC pulse trigger signal and the angular pulse

sampling signal.
(1) External Trigger Input Switching

Disconnect

(2) Trigger Source Switching
Disconnect

(3) Time base Source

Select TRIGIN.
(4) Time base Signal ON/OFF

Connect CMNCLK to the slot as a time base  signal.

(5) Press Update to apply the settings.

(2)

(4)

(3)
(5)

(1)

Appendix 1  Setting Up the WE7000



App-5IM 707765-61E

A
p

p
en

d
ix

App

<Scaling Information Settings>
Set all input signal scaling settings to Not Available.

<Sending Settings to the Station>
Right-click the station name for the station list window then select Update Preset Values
from the menu.  The above setting conditions can be sent to the station.

<Exiting the Control software>
Check that you can measure cylinder pressure using the WE7272 and the control
software.  Exit the control software. This concludes the setup.

Appendix 1  Setting Up the WE7000
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Appendix 2 Setting Up the DL750

First, enter all necessary settings on the DL750.  The following is an example of how the
DL750 would be configured to measure the pressure in one cylinder with one 701251

measurement module.

 Signal Connection

 Ethernet

Angular pulse
( TTL level signal)

CH1: Cylinder pressure

CH2: TDC pulse
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Connect an Ethernet cable to the main unit and turn on the power.

<Network and User Account Settings>
(1) Press the MISC key.
(2) Press the Network soft key.

(3) Press the TCP/IP Setup soft key. The TCP/IP setup menu is displayed.
(4) Press the User Account soft key. The User Account Setting menu is displayed.

 

MISC

The setup procedure is explained in the DL750 user’s manual.  Also, you must enter the
network information and user account information that you set here in the Monitor

Function add-on for the Engine Combustion Pressure Analysis (see section 6.2).
After entering the above settings, enter the DL750 IP address in a web browser and
confirm that the screen below is displayed.

Appendix 2  Setting Up the DL750
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<Remote Control Settings>
Set so that remote control is available through the network.

 

MISC

Appendix 2  Setting Up the DL750
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<CH1 (Cylinder Pressure Signals) Settings>
Choose a range using the V/DIV knob.  Also, press the CH1 key to enter settings for

CH1 as follows:

CH1

* Linear Scale = OFF
 Label = CH1

<CH2 (TDC Pulse Signal) Settings>
Choose a range using the V/DIV knob.  Also, press the CH2 key to enter settings for

CH2 as follows:

CH2

* Linear Scale = OFF
 Label = CH2

Appendix 2  Setting Up the DL750
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<Trigger Mode Settings>
Press the MODE key to set the trigger mode to Single.  This is automatically set with the

Monitor Function add-on for the Engine Combustion Pressure Analysis.

<Trigger Settings>
Press the SIMPLE/ENHANCED key, and set the TDC pulse signal (CH2) to the trigger
source.  Enter the Level, Slope, and Hysteresis for the TDC pulse signal.

<Pretrigger Settings>
Press the POSITION key to set the Position to 0.0%.

MODE SIMPLE/ENHANCED POSITION

Appendix 2  Setting Up the DL750
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<Waveform Loading Settings>
Press the ACQ key to set the record length and time base.

Enter settings as follows for the record length.
Record length ≥ (no. of analyzed cycles + 3) × 1 cycle data length
For 4-cycle engine: 1 cycle data length = (360/res) × 2

For 2-cycle engines: 1 cycle data length = (360/res)
res = angular resolution (1, 0.5, 0.25, 0.1)

For example, with a 4-cycle engine at an angular resolution of 0.5 CA, and 100 cycle’s

worth of data acquired:
From the equation: Record length = (100+3) × 1440 = 148320, enter 250 k.

This is automatically set with the Monitor Function add-on for the Engine Combustion
Pressure Analysis.
Set Time Base to Ext so that the angular pulse signal will be used as the EXT-CLK.

ACQ

<Concluding Setup>
Confirm that cylinder pressure can be measured using the START/STOP key.  This

concludes the setup.

Appendix 2  Setting Up the DL750



Index-1IM 707765-61E

Index

In
d

ex

Index

Calculated TDC correction value ...................................... 3-18
calculation ......................................................................... 3-22
calibration factor ....................................................... 3-17, 6-13
cascading fashion ............................................................. 3-24
channel names .................................................................. 3-18
clearance volume .............................................................. 3-20
combustion efficiency ........................................................ 5-27
combustion mass rate ....................................................... 5-21
combustion pressure analysis data items ........................... 2-4
comments ........................................................................... 3-5
communication interface ..................................................... 3-8
composition ratio of ethane ............................................... 3-20
composition ratio of isobutane .......................................... 3-20
composition ratio of methane ............................................ 3-20
composition ratio of n-butane ............................................ 3-20
compression ratio .............................................................. 3-20
compression/expansion work .............................................. 5-7
con-rod length ................................................................... 3-20
concentration of oxygen remaining in exhaust gas ........... 3-20
cooling loss ....................................................................... 5-25
cooling loss ratio ............................................................... 5-25
crank angle at combustion mass rate N1 % ..................... 5-22
crank angle at combustion mass rate N2 % ..................... 5-23
crank angle at combustion mass rate N3 % ..................... 5-23
crank angle at maximum amount of heat release ............. 5-20
crank angle at maximum cylinder gas temperature .......... 5-17
crank angle at maximum cylinder pressure ........................ 5-4
crank angle at maximum rate of cylinder pressure rise ...... 5-5
crank angle at maximum rate of heat release ................... 5-19
crank angle graph ..................................... 3-1, 3-12, 6-6, 6-10
crank angle graph data items (.csv file) .............................. 4-3
crank angle graph data of specified range of cycles ........... 4-5
cursor .................................................................................. 3-2
cursor (monitor) ................................................................... 6-6
cutoff ................................................................................. 3-16
cycle graph ......................................................... 2-5, 3-1, 3-14
cycle graph data items (.csv file) ......................................... 4-4
cycles .................................................................................. 3-2
cylinder gas temperature ......................................... 5-11, 5-17
cylinder pressure ................................................................. 5-1
cylinder pressure after absolute pressure correction .......... 5-1
cylinder-to-cylinder TDC correction ................................... 3-18

D

data name ........................................................................... 3-5
data type ................................................................................ ii
degree of constant volume ................................................ 5-28
department .......................................................................... 3-5
directory structure ............................................................. 2-10
display channels .......................................................... 3-1, 6-6
DL708E ............................................................................... 1-1
DL716 ................................................................................. 1-1
DL750 ................................................................................. 1-2
DL750 IP address ............................................................... 3-9
DL750 USB ID .................................................................... 3-9

E
end cycle ...................................................................... 3-3, 3-5
end point of combustion .................................................... 3-20
engine combustion pressure analysis ................................. 1-3
engine model ...................................................................... 3-5

Symbols
.csv ............................................................................... 2-7, 2-8
.ecm .................................................................................... 2-8
.ecp ..................................................................................... 2-8
3D graph .................................................................... 3-1, 3-13
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A (calibration factor) .......................................................... 3-18
about ECP ........................................................................... 3-2
absolute pressure correction ............................................... 2-4
amount of heat release ..................................................... 5-20
amount of heat release during the combustion period ...... 5-21
amount of water produced ................................................ 5-11
analysis conditions .............................................................. 2-8
analysis data items graphed in 3D ...................................... 2-5
analysis results of a specified range of cycles .................... 2-8
angular resolution ...................................................... 3-3, 6-15
arrange icons .................................................................... 3-26
atmospheric pressure ....................................................... 3-20
atmospheric temperature .................................................. 3-20
average amount of heat release ....................................... 5-20
average amount of heat release during the combustion ... 5-21
average combustion mass rate ......................................... 5-22
average cylinder gas temperature .................................... 5-17
average cylinder pressure ................................................... 5-2
average cylinder pressure (absolute pressure correction) .. 5-1
average end point of combustion ...................................... 5-29
average intake manifold pressure ....................................... 5-1
average rate of cylinder pressure rise ................................. 5-3
average rate of heat release ............................................. 5-19
average ratio of specific heat ............................................ 5-18
average start point of combustion ..................................... 5-29
averaged angle at combustion mass rate N1 % ............... 5-22
averaged angle at combustion mass rate N2 % ............... 5-23
averaged angle at combustion mass rate N3 % ............... 5-24
averaged angle at maximum amount of heat release ....... 5-20
averaged angle at maximum cylinder pressure .................. 5-4
averaged angle at maximum rate of heat release ............. 5-19
averaged IMEP ................................................................... 5-8
averaged maximum amount of heat release ..................... 5-20
averaged maximum cylinder gas temperature .................. 5-17
averaged maximum cylinder pressure ................................ 5-4
averaged maximum rate of cylinder pressure rise .............. 5-6
averaged maximum rate of heat release .......................... 5-19
averaged NMEP .................................................................. 5-8
averaged PMEP ................................................................ 5-10
axis range .................................................................... 3-1, 6-6

B

B (calibration factor) .......................................................... 3-18
BMP file ........................................................................ 3-2, 6-6
boost pressure .................................................................. 3-20
bore ................................................................................... 3-20
brake thermal efficiency .................................................... 5-26

C
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engine power .................................................................... 3-20
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excess air factor ................................................................ 5-12
exhaust gas ....................................................................... 5-11
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F ............................................................................................. ii
filter .......................................................................... 3-16, 6-12
filter processing ................................................................... 2-2
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friction loss ........................................................................ 5-26
fuel consumption ............................................................... 3-20
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gas mixture constant ......................................................... 5-16
graph colors ................................................................. 3-2, 6-6
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I
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indicated efficiency ............................................................ 5-28
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maximum cylinder gas temperature .................................. 5-17
maximum cylinder pressure ................................................ 5-4
maximum piston displacement .......................................... 5-27
maximum rate of cylinder pressure rise .............................. 5-5
maximum rate of heat release .......................................... 5-19
measured concentration of oxygen ................................... 3-21
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measured fuel consumption .............................................. 3-21
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measuring station ................................................................ 3-9
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method of absolute pressure correction ............................ 3-20
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monitor function of engine combustion pressure ................ 1-4
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numeric analysis data items ....................... 2-5, 3-15, 6-6, 6-11
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